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A better title for this column might be “Patents or
Innovation”. I am not a lawyer, and I don’t even play
one on TV. In fact, one of the things I really like
about living in Nicaragua is that lawyers are low-paid
people who stand in lines for you and not much
more. I do have, however, some opinions that hit
the edge of legal issues. Here goes.

When I was a kid playing with electronic gizmos
in my parents’ basement, I remember reading 
various tips in electronic magazines by Don
Lancaster. Don seems to have outlived the publi-
cations he wrote for, so I will consider his advice
useful. After writing an assortment of books—the
oldest of which I remember was called The TV
Typewriter Cookbook—he wrote one called The
Incredible Secret Money Machine. This was a
book about his life, which focused mostly on
how he supported himself.

I bought and read the book. It had quite a lot
of wisdom in it, but to me, his advice on patents
was the most important. He said that if you
invent something and start selling it, then you
can be working on your next invention while
everyone else is trying to figure out how to copy

what you did. In other words, innovate and then
innovate again, rather than getting bogged down
with the lawyers.

Today, I read all too much about the legal side
of life in technology. This includes a regular stream
of totally absurd patents. I won’t bore you with the
details, but if I saw one for making ice by freezing
water, I wouldn’t be too surprised.

I recently saw a post on the Free Software
Business mailing list from someone who has done
some software innovation and is concerned about
possible legal action against him when he releases
the software. Now, he didn’t steal the idea—he
just figures that there is a chance someone has a
patent on it or on part of it.

Let’s say you did design a machine that makes
ice by freezing water. It might be computerized or
at least have an indicator light that comes on
when the water is frozen. Chances are you are an
engineer, not a lawyer. The way the patent system
works, you need either to start working on your
law degree or hire a lawyer to do a patent search
before you feel comfortable starting the manufac-
turing of your new-fangled machine.
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On the other hand, if you could just
get that machine into production, you
could put your innovative mind to work
on something new—maybe a device to
make steam by boiling water. Again,
you could incorporate a computerized
system or a light that tells the user
when the water is boiling. (I mainly sug-
gest this as I am sure there are lots of
patents on whistling tea kettles.)

The counter argument is that big
companies won’t invest in innovation
unless they can get some protection for
what they create. I am not sure this is
the case. If the innovator is a big com-
pany, it will have visibility and market
share already. That gives the company
the head start Don Lancaster talked
about. If the innovator is the little guy,
he probably won’t have a huge invest-
ment, and he always has the choice of
selling his invention to someone with

market share.
This is a Linux magazine, so it is

time to reel this in to how it applies to
Linux. First off, the Linux kernel is not
patented, but beyond that, there are
very few patents related to the UNIX
operating system. This means that
Linux could become what the commu-
nity needed rather than having to be a
collection of compromises to avoid
patent conflicts. Further, as many of
the pieces of the basic UNIX design
went into creating an industry standard
(POSIX 1003), Linux could comply with
a standard rather than being forced to
diverge from it.

Next, because Linux is small in desk-
top market share today, innovation is
likely to enter into building more mar-
ket share. To copy what someone else
has done is not the way to increase
your market share. You need to do it

better. Whether that is an office suite
that doesn’t force you to buy the new
version or a general system design that
protects you from worms and viruses,
there has been room for innovation
and it is happening.

In writing this article, I realized that
if there was one thing that should have
been patented by Linus Torvalds, it was
the way a diversified workforce created
Linux. I am fairly confident that there
has never been a case of such a totally
diverse workforce (geographically, in
native language and in skill level) work-
ing together to create any decent-sized
software system. In fact, this happen-
ing by a group of volunteers world-
wide shows that innovation can hap-
pen without a company looking for
patents or even employees looking for
a paycheck.

Draw your own conclusion, but like
most of the Open Source Software com-
munity, you aren’t going to see me climb
on the software patent bandwagon any
time soon. I’m all for free the technology
and letting the user decide.�

Phil Hughes is Group Publisher for SSC Publishing, Ltd.
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I just finished editing another batch of
letters. As usual, they contain a num-
ber of complaints about how we are
KDE-obsessed and don’t cover GNOME
enough. One letter claims that the
only software we have covered so far
is KDE-specific software. And, of
course, GNOME fans are having
spasms about Mango Parfait’s opinions
of GNOME. I’m sure they will be
equally thrilled with her sarcasm about
GNOME in this issue. My suggestion to
these folks is to lighten up and stop
taking her comments so seriously. I’m
sure this isn’t the first time someone
has poked fun at something you like.
If you’re so convinced that GNOME is
best, that’s all the more reason you
should be at ease when people criti-
cize it. You know better, right?

Before I deal with the issue of
GNOME coverage in TUX, let me say a
few words about how I feel about
GNOME. I dislike it. That shouldn’t mat-
ter. We all have our preferences. If you
like GNOME, use it. If you hate KDE,
great. I have no problem with that.

Different strokes for different folks.
What bothers me is not GNOME, but

that we critics of GNOME have been
accused of disliking GNOME simply
because we don’t understand it. I don’t
think that’s the case, but if we really
don’t understand it, shouldn’t that tell
you something? Why wouldn’t we
understand it? Could it be because
GNOME is one of the most unintuitive,
inconsistent desktop environments ever
designed? Could it be because GNOME
keeps undergoing dramatic changes in
its philosophy toward how a desktop
should behave?

Indeed, the frequent overhauls to
the philosophical approach to how a
desktop should behave puts GNOME
evangelists and defenders in a very
awkward position. Take Nautilus, the
file manager, for example.

“It’s great because it does every-
thing.” When GNOME dumped the
buggy Midnight Commander file manag-
er in favor of the original version of
Nautilus, the hype was all about how
Nautilus would be a Swiss Army knife for

GNOME. It was a file manager, browser,
system administration tool, package
manager and more. It was considered
the core component of GNOME. See
http://www.businesswire.com/webbox/
bw.032001/210790539.htm for a sample
press release in 2001.

“It’s great because it’s so simple
and does only basic tasks.” Later,
GNOME developers decided to rip out
most of the features in Nautilus and
strip it down to basics for the benefit
of speed and ease of use. But if you
read the press release mentioned
above, the original point of making
Nautilus do everything imaginable was
for the benefit of “ease of use”. So
which approach actually made GNOME
easier to use?

“It’s great because it has a revolu-
tionary new spatial design.” Then
Nautilus morphed into a “spatial” file
manager. This “spatial” file manager
was supposedly revolutionary,
although anyone who has used OS/2
knows better. The idea was that every
folder should have its own size and

Who Let the GNOME Dogs Out?
Complaints by GNOME fans unfounded, and some actions by evangelists underhanded.

NICHOLAS PETRELEY

FROM THE EDITOR IN CHIEF
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place on the desktop, which gives that
folder a unique “spatial identity”. Every
time you opened a folder, that folder
would appear in the same position and
size on the desktop you had used the
last time you visited that folder.

Unfortunately, whenever you open a
new folder, the previous folder window
remains on screen. As you navigate
deeper through subfolders, your screen
becomes cluttered with open windows.
When I complained to a GNOME advo-
cate about this behavior, his response
was that I could change the default
behavior of Nautilus back to the way it
used to work by changing a registry
setting. A registry setting? That’s
GNOME’s idea of ease of use?
Eventually the Nautilus developers
relented and added a preferences
option to choose between the new
“spatial” behavior and the old explorer
version of Nautilus.

“It’s great because it’s not spatial
anymore.” Now I’ve downloaded and
installed the preview of Ubuntu 5.1,
which includes the latest version of
GNOME. I assume that GNOME still
makes the “spatial” behavior of
Nautilus the default behavior. I don’t
know. But Ubuntu makes Nautilus
default to an explorer mode that works
similarly to prior versions of Nautilus.

This raises the question, if the “spatial”
approach to file management was so
terrific and simply misunderstood and
underappreciated, why did the Ubuntu
team decide not to use it by default?

I’d applaud the change, but the new
Nautilus explorer mode includes one of
the most abominable features ever con-
ceived, ostensibly “borrowed” from the
hideous GNOME file picker. In one of the
toolbars, you’ll see a back arrow, after
which buttons appear as you navigate
through folders. Each button represents a
folder, a subfolder, a sub-subfolder and
so on, as a history of where you’ve been.
If you go back one step, it keeps the
extra button there, in case you want to
go forward again.

Why buttons are supposed to repre-
sent folders is a mystery to me. But
here’s a bigger mystery. If you navigate
deep enough, there’s no room for all
the buttons, so a scroller appears. A
scroller for buttons? Now that’s revolu-
tionary. This is especially a problem
with the file picker, where there’s even
less space for the buttons. Worse, I still
haven’t figured out why the back arrow
I mentioned earlier creates two buttons
called home and then changes into an
icon that, if clicked, takes me to the
top level of the entire filesystem. This 
is intuitive?

Here’s the point. GNOME defenders
can rant all they want about how critics
simply misunderstand it. The problem
illustrated by the crazy history of Nautilus
is that there’s no “it” to misunderstand.
If “it” is so great, why does “it” keep
going through so many radical changes
in philosophy? I have sympathy for long-
time GNOME advocates because they’ve
had to defend both the original designs
and the contradictory overhauls as being
the best approach.

One more word about the changes
in the latest version of GNOME. The
new file picker (file open and file save)
dialog now has a panel on the left
where you can add bookmarks to fold-
ers. This way, you can return to fre-
quently used folders quickly. These
bookmarks also show up in Nautilus—I
assume for the sake of consistency.
KDE has had a more attractive version
of this feature for ages, except KDE lets
you associate bookmarks with applica-
tions. In other words, if I so choose, I
can have one set of bookmarks appear
when I use the word processor and
another set appear when I use the
spreadsheet. This way the application
“knows” how I organize my files.
Needless to say, you can’t do that with
GNOME bookmarks, so the file picker is
destined to become cluttered with
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bookmarks that point to folders, which
don’t relate to the current application.
The good news is that the GNOME
developers are beginning to see the
benefits of including some of the KDE
features. If this trend continues,
GNOME can only improve.

Okay, so now you know a few rea-
sons why I don’t like GNOME. I have
many more reasons, but I’ll spare the
GNOME fans the agony of reading
them. There are also many things about
GNOME that I like. But they don’t offset
the bad things enough to make me
want to use it.

TUX COVERAGE OF GNOME
The amount of coverage we give to
GNOME has nothing whatsoever to do
with my opinion of GNOME, and our
publishing history proves it. We focus
on KDE more than we do GNOME,
because our readers prefer KDE to
GNOME three to one. But we do not
ignore GNOME.

By the way, this ratio was almost
corrupted by ballot-box stuffing.
Someone on the GNOME marketing
mailing list noticed the TUX Readers’
Choice Awards and said that they
should notify their fans to go partici-
pate in not only the TUX poll, but in all
such polls. In other words, this was a

call to rally the troops to stuff the ballot
boxes in desktop polls.

In the case of TUX, it was too late.
The TUX polls were closed by the time
this message made it to the GNOME
marketing mailing list. By the way, I
searched several KDE mailing lists, and
saw no mention of the TUX Readers’
Choice Awards. Regardless, this is the
kind of activity that taints the results of
any Readers’ Choice Awards. If we see
fans of any type of software rallying
troops to vote in our polls, we will
invalidate that poll. That would be a
tragic day in our history, because
Readers’ Choice Awards are an impor-
tant part of TUX.

But here’s what mystifies me most.
Why do we get so many letters com-
plaining about our obsession with KDE
and lack of GNOME coverage? We cer-
tainly do not cover only KDE software, as
someone claimed. In fact, many, if not
most of our articles deal with software
that is not specific to GNOME or KDE. To
name a few examples, we have pub-
lished articles about Thunderbird,
OpenOffice.org, Inkscape, GIMP,
Cedega, IceWM and more. We have
published articles about GNOME-specific
software, such as Tomboy and, in this
issue, gThumb and GnuCash.

As for a lack of attention to GNOME,

Mango Parfait, who loves to portray a
hatred of GNOME that knows no
bounds, has gone to great lengths to
answer several questions about GNOME.
So even where you’d least expect it,
you’ll find detailed coverage of GNOME.
Think, folks. If she is not just having fun
pushing the buttons of GNOME fans,
and she truly detests GNOME, how is it
that she knows GNOME well enough to
answer questions about it? One might
suspect she gets her answers from her
boyfriend, Otaku, but she says he’s a
KDE fan, too.

So, many of the people who com-
plain that we are obsessed with KDE
and never deal with GNOME, obviously
aren’t reading TUX. Has someone told
GNOME fans and evangelists to spam
us with these letters? I don’t know. But
if so, it’s time to call off your dogs. TUX
will become a GNOME-focused maga-
zine the day GNOME users vastly out-
number KDE users. So if you GNOME
fans want more GNOME coverage, I
suggest you improve GNOME first. Until
then, we’ll continue to publish accord-
ing to the balance that we believe
serves our readers best.�

TUX Editor in Chief Nicholas Petreley is an author,
consultant, programmer, award-winning columnist
and Linux analyst for Evans Data Corp.
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Yay Linspire!
Thank you for printing my Letter to the Editor in
the September 2005 issue. I just wanted to follow
up and report that I have indeed installed Linspire
5.0! I also have their CNR service and all I can say
is, WOW! This is the absolute cutting edge of
computing! Someday, all OSes will be delivering
software this way. But with Linspire, you have it
today and it is flawless! Linspire really is the easi-
est desktop Linux in the world! Thanks again for
pointing the way.
--
Mark Szorady

Tools for Basic Programming?
First of all I have to say that TUX is one of the best
Linux magazines. It’s written by Linux users for
Linux users. Good job. In the Letters section
[September 2005], I found a letter written by
Alan, who asked about Basic Programming under
Linux. Well, there are tools available. Just see
these pages to get a better overview: GAMBAS
(http://gambas.sourceforge.net) and REALBASIC
(http://www.realbasic.com), which offers now a
private Linux version for free.
--
Alex

More on Terminal Commands
I would like to echo the comments of Sydney Nash
in September’s TUX Letters section. Specifically, the
“50 Commands Every Linux User Ought To Know”

suggestion. I was recently cleaning out a bag of
“goodies” I got at the last FOSE show here in DC
when I came across a Ubuntu CD. I was reluctant
at first, but decided to load the OS on a laptop I
barely used (just in case I really messed it up). That
was less than a month ago and now that laptop is
my most-used computer.

I have made many mistakes along the way, but
resources such as TUX and Ubuntu’s Web Forums
have been immensely helpful. I do think many
new users would benefit from an article outlining
useful terminal commands. Let’s face it, most
users learn new things about their computers sim-
ply by playing, and without proper direction that
playing could be damaging. I thought your maga-
zine is about teaching new Linux users how to
operate in this new environment, not just about
teaching them how to point and click, we already
know how to do that.
--
Matthew Anthony

Boo KDE
I want to write to thank you for the excellent arti-
cle in the September 2005 issue [John Knight’s
“The World Beyond KDE and GNOME”]. I am
gratified to see you doing some articles about
lightweight desktops. Frankly, I am bored with the
KDE love-fest at your publication. For all of you
noobs out there, don’t listen. KDE is excessive
eye-candy goop. GNOME is better. Well, okay, it

would be better if spacial Nautilus wasn’t so com-
pletely awful. I mean, it really does suck doesn’t it?
Sigh. And your excuse of “we cover more KDE
because most people use it” is extremely lame. Just
do a Windoze magazine then—95% of PC users
use it right? Therefore it must be better, right?

Okay, back to the reason I’m writing. I’d love to
see a TUX article about Fluxbox. It is the best
lightweight WM out there, and when paired with
the Rox Filer, it really is an awesome desktop. I’ll
use it with about 80% GTK apps and 20% KDE
apps and just giggle at the KDE vs. GNOME fight.
Oh wait, wasn’t I just ranting about that? Oops.
--
KRK

Scribus?
I’ve been most impressed by your magazine over
the last few months since I discovered it. It’s a real
breath of fresh air, and it fulfills the long-neglected
purpose of helping Linux users (old and new alike)
get the best out of their systems, without all the
techno-geek-speak that tends to bog down other
publications in the field. I’ve been using Linux for
a few years now, but I still discover new things
from your mag. I particularly like the articles with
the tips on how to use different applications.
When all is said and done, what average users
want to do is sit down and get the most out of
their apps—whether it’s an office suite, image edi-
tor or audio and video tools, etc. You’ve men-

LETTERS
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tioned in recent editions that you intend to move
the production of TUX to using Scribus. I’ve tin-
kered with Scribus and think it is a marvelous
desktop publishing application, though perhaps
not as rich as Adobe InDesign. I would really like
to see an article or two on how to do things in
Scribus. Perhaps you could use the design of your
own magazine as a demonstration. Keep up the
good work.
--
Lloyd Brady

Is Mango a Woman?
Here are answers to some of the questions posed
in your magazine last month, with some questions
of my own mixed in:

My favorite Linux OS so far is PCLinuxOS, but I’m
about to try Linspire 5.0, which as you know is
free to download till September 6. Who knows, I
may subscribe to the updates. We’ll see.

Is Mango Parfait really a woman? How about a
real photo to prove it? It’s unbelievable that a
beautiful woman is this much of a Linux expert.
Did I say unbelievable, I meant f__in’ unbelievable,
which is more in “her” style of speech.

I used to prefer GNOME because it worked better in
the older Mandrake version I used to use. SUSE was
okay in KDE. I think KDE has improved, because
now I like it well enough that I see no reason to go
back to GNOME anymore (in PCLinuxOS).

I always read TUX cover to cover, is there any other
way? I like the landscape format. It reads very well
on my laptop! I always learn new things reading
your magazine.

I’m not a newbie anymore, but I don’t always go to
the command line if the GUI tool is convenient. My
way is whatever is easiest and fastest, so it depends.

Firefox, Gmail (or Kontact) depending on where I
read my e-mail.

Please do show us how to install two or three
Linux OSes on the same system; include WinXP
Pro as the Windows version, which is also on the
multiboot system.

Thanks for asking. I really like your magazine.
Keep up the good work and the continual
improvements, issue to issue.
--
Emil J. Wisekal

It is rather chauvinistic to suggest that a beautiful
woman cannot know as much or more about
Linux than a man. Having said that, Mango has
two things going for her. First, she was hand-
picked by publisher Phil Hughes, and Phil knows
what he’s doing. Second, Mango admits that she
sometimes solicits help from her on-and-off-
boyfriend Otaku. How much help she needs is
anyone’s guess. We don’t care as long as she
keeps getting it right. Regardless, if you read her

first column, you’d know that she is willing to kick
the keister of anyone who suggests she doesn’t
know Linux because she’s a girl. So I’d watch out
if I were you.—Ed.

More on REALbasic
In response to the September 2005 Letter “Don’t
Be Afraid of the Terminal Window”, I’ve found
that using http://linuxcommand.sourceforge.net
is a VERY informative tutorial on most things
terminal (sorry, no pun intended). As well as the
oh-so-simple man pages. And for the real brave,
man bash will give you a world of information.
And, regarding the “Basic Programming?” letter,
there is an AWESOME (IMO) IDE/compiler called
RealBASIC (free Linux version, retail version makes
cross-platform executables), which are totally free
for Linux use and tries very hard to be source-
compatible with Visual Basic.
--
Rob

Incidentally, a new version of REALbasic,
REALbasic 2005 for Linux, became available on
September 13. Check out the details at
http://www.realsoftware.com/visualbasic.—Ed.

Boo Mango
I love your magazine; it has been instrumental in
my changeover from Windows over the last year,
and it is a service to the Linux community. But I
must join the never-ending horde who protest
against the ramblings of Mango Parfait.
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Her tirade over the GNOME desktop at the start
of the last issue is downright offensive! Is it really
necessary to make references of wiping one’s
backside in order to present her childish opinion
on whether KDE is better than GNOME? What’s
more, she then goes on to tell a guy that if her
instructions aren’t exact to his operating system,
he should upgrade his OS, and on a completely
unrelated note, change to KDE just to suit her.

She continues this trend by telling another guy how
terrible Fedora is for installing programs, and tells
him to get an entirely new package manager, taking
another dig at GNOME in the process. She mentions
the default system as an afterthought or “the worst
way”, which, given the arduous set of instructions
above, also seems to be the simplest way.

Though I find her humor unfunny, I can deal with it,
as it’s a matter of personal taste. Dealing with more
than one widow manager is unrealistic, and I realise
that by choosing KDE, you are catering to the widest
possible audience. But this kind of childish behavior is
a sea anchor on your publication, dragging down the
quality of the entire piece. The Linux community is
seen by outsiders as a bunch of socially inept geeks,
and this kind of attitude toward different opinions
encourages that belief.
--
terence

You may find her humor unfunny, but at least you
recognize some of it as humor. Do you honestly
believe Mango was realistically suggesting that

the reader upgrade to make her life easier?
Lighten up.—Ed.

Calc Can Do It
In the last issue of TUX, Mr Simms, in his letter,
claims that it is not possible to depict multiple xy
data sets on a single graph using OpenOffice.org
Calc. Quote, “For example, in OpenOffice.org Calc
there is an open issue to include multiple x ranges
in a single plot. In other words, a way to plot dif-
ferent x,y sets of
data on the same
plot that Excel
allows currently, and
has for a while, but
Calc doesn’t.”

This is incorrect.
The attached
Battery
Performance
spreadsheet (sorry
a bit scrappy)
shows how this is
done using
OpenOffice.org
1.1.4 Calc. You
just have to com-
bine the x data
into a single column
and enter the y
data in separate
columns. It may
not be quite as

easy to set up as in Excel, but visually the end
result is indistinguishable from the Excel version.

I migrated to Linux about six months ago, after
using M$ products for some 25 years. At the
moment, I can’t see any real need to go back.
Great Mag—it’s helped me a lot already. Keep up
the good work.
--
Andy Carter
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Anti-KDE
In the last issue, you make much of the GNOME-
vs-KDE debate. In your own words, you refer to
“The number of Linux developers using KDE is
increasing. The number of Linux developers using
GNOME is shrinking.” Developers? I thought TUX
was a magazine for people that were new to
Linux—folks (like myself) who can’t write code for
a hill o’ beans but want a desktop environment
that looks good, doesn’t get in the way and lets
us do what we want to do.

I’ve tried, really, I have—I currently have SUSE 9.3
Professional installed along with Ubuntu (and
Windows XP Pro, but that’s another story), and
I’ve installed several other KDE-based distros (such
as PCLinuxOS), but I just don’t get it. KDE contin-
ues to be too “busy”, a little too frenetic for my
tastes—and it’s just plain ugly (IMHO). Perhaps the
4.0 release will address these issues—I hope so.

The good news is that Linux does not lock us in to
a single, set desktop, a la MS Windows. Choice,
after all, is one of the major causes of the open
software revolution. Let’s hope it continues! As I
hope this magazine continues.

PS. I find the Mango Parfait column shrill, annoy-
ing and way too full of attitude—but, again, it’s a
matter of choice.
--
Mark W. Tomlinson

The point was that if developers are favoring KDE,
how much more are normal users? That was just
speculation until we got the answer from our
Readers’ Choice poll. Our readers favor KDE by a
3-to-1 margin.—Ed.

Thanks TUX
I started using Linux about eight months ago. I
had a relapse for two months and went back. My
friend started me out with Slackware (very stable).
I used it just for an experiment, but now it’s all I
use. I have tried others and don’t care for them.
The so-called hard distros are not bad if you have
a Linux friend and an account on
linuxquestions.org. I just wanted to thank you for
writing such a great magazine. I stumbled upon it
just before issue #1, and it’s very nice. It’s just
what it’s intended to be, and I love it. I would love
to have a printed issue to carry and show off (my
printer isn’t going to shell out 60 pages and have
no ink every month!), but the free version is
extremely cool. I will soon be doing my second
person-to-Linux conversion, and I can successfully
do it with such an awesome magazine.
--
Samuel

More Thunderbird Extensions
About the article “Extending Thunderbird: the
Best of All Worlds” [September 2005]—I like the
article, but I think there are two very important
extensions that should be mentioned that were

not. These include Delete Junk Context Menu,
which makes handling junk mail much less of a
hassle (I don’t know why they didn’t include that
as a default feature), and View Headers Toggle
Button, which lets you view all header information
in an e-mail with the touch of a button. Like it or
not, all users of all operating systems should know
how to read and interpret certain parts of an e-
mail header as part of safe Internet usage. I’ve
used this a few times already to provide adequate
information to report abuse and phishing at well-
known Web sites.

About GNOME coverage—I understand the rea-
sons that you cover KDE, and I don’t argue with
that. However, I would suggest at least some
coverage of GNOME to expose new users to the
alternatives. After all, isn’t that the point of
TUX, to expose new users to what is available
to them? My own experience with learning how
to use Linux included KDE and GNOME, and I
personally prefer GNOME because of the
smoother appearance and more feature-rich
applications (granted my comparison was done
about three years ago, and I just haven’t had
the desire to check out KDE since). Also, as
time goes by, we may see a convergence of
how these two desktops work as they continue
to comply with the OpenDesktop initiative.
Keep up the good work with the magazine!
--
James Payne
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Networking Suggestion
I have just received my first edition of TUX and am
just writing to say that you blokes (and blokettes)
are Number 1. Excellent layout, presentation, con-
tent and “feel”. In short—I’m in!

I am an intermediate (mad scientist) user on
Windows and am making my first foray into Linux
(currently Ubuntu because everything worked out
of the box), and I am about to try Vector Linux. I
have tried Mandrake 10 but found some teething
problems (probably my fault). An article on how
new users may add all those beautiful transparent
windows and widgets would be only too welcome.

Many new Linux users will be changing from
Windows (or are trying) and will have at least two
or three computers networked (wireless seems
huge at the moment), so I’m wondering if an arti-
cle on simple network setup, just to connect the
PCs together, might also be a good read?
--
Peter

Yes, We’re Mind-Readers
You must be reading my mind! Thank you so
much for starting some articles about Inkscape. I
have just installed it on my Mandriva box and am
looking forward to learning how to use it. Some
GIMP tutorials would be great too. I also have
Inkscape on my Windows machine. Are there any
differences between the two program versions?
--
C. Dempsey

As for the differences between versions of
Inkscape, you’ll have to ask the Inkscape develop-
ers! We don’t do Windows.—Ed.

Not Just for Newbies
You say that you aim at beginners, but as a Linux
user for ten years, I enjoy your magazine a lot!
There are tons of wonderful programs out there
and due to the nature of open source (no market-
ing budgets!) very few people know about them.
You not only publish a great magazine but also
make a big contribution to free software.
--
Tansu

Kubuntu and Ubuntu
I wish to contradict a little bit of what you said in
your Editorial in the August 2005 issue of TUX
magazine. Maybe not so much a contradiction, but
a difference in experience with Ubuntu/Kubuntu.

First, given the purpose behind TUX magazine (that
is, serving the interests of Linux beginners), I would
not suggest using Kubuntu yet. I recently tried it out
and was very frustrated with numerous issues, which
are admittedly problems with the fact that Kubuntu
is really in the development stage. If you go to their
forums you will see a plethora of complaints, the
reply to which is generally, “well, it’s not ready yet.”

Fortunately, it was quite easy to turn Kubuntu
into Ubuntu, so I didn’t have to reinstall.

When I first installed Ubuntu, it was at version 4.1, I

believe. Being unfamiliar with GNOME and having
problems configuring it to do what I wanted, I gave
up on it. But again, instead of reinstalling my favorite
distro Debian, I turned Ubuntu into Debian. You are
probably right that this is not advisable for the begin-
ner. As I recall the solution really lay in removing
many packages and then installing the proper
Debian ones. And everything worked the way I
wanted it to. Anyhow, it was, at least on the 4.1 ver-
sion, rather easy to Debianize an Ubuntu installation.

As for 5.x version, I can’t say for sure how easy it
would be Debianize it, but I have the feeling the
solution would be similar. Contrary to what you
say, after Ubuntu-izing (sic?) Kubuntu, I found
that there were a number of packages that I
wanted that weren’t available. So, I just went to
http://www.debian.org/distrib/packages and
grabbed the package from unstable or stable. And
then I installed it with dpkg -i. So I am not at all
sure why you say that you can’t use “pure Debian
software”. I’ve been doing it all along.

Finally, I want to say that it turns out there is a
more-Ubuntu way of getting packages installed
that aren’t available when you do the default
install. You have to edit sources.list and add:

deb http://archive.ubuntu.com/ubuntu/ hoary universe

deb-src http://archive.ubuntu.com/ubuntu/ hoary universe

Apparently, there is also a way to do this through
the Synaptic Package Manager by choosing “uni-
verse” from the repositories section. But I never
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use Synaptic, so I wouldn’t really know for certain.

As a final note: for beginner users, Fedora Core may
be a good solution. However, I find pretty much all
my colleagues are abandoning Red Hat. No one
seems to like the steps Red Hat is taking with respect
to Linux and prefer something more stable (not in
terms of uptime, but in terms of maintaining a Linux
directory structure, and so forth). So, I personally tell
people to stay away from Fedora Core. Also, as far
as I’m aware (and maybe I am very wrong), but
upgrading across versions of Fedora Core is not as
easy or pretty as updating across versions of Debian
(including Ubuntu). Therefore, I always suggest
Debian-based versions. Of course, as I have admit-
ted, Debian is my favorite distro, and so I am not
impartial and I am not so familiar with Red Hat.

PS. You guys are doing a great thing! I suggest
your publication to all Linux colleagues and poten-
tial users. Whether a novice or a guru, it is a good
tool to know about and spread the revolution.
--
Curtis Vaughan

More GNOME vs. KDE
I just polled our LUG and the responses I got were
that five users use GNOME, one and a half use
KDE and one uses Fluxbox. I don’t question your
source that says KDE is most popular, but it’s just
not been my experience, and whatever, TUX would
be much better if it were more GNOME-friendly.

My reading pile’s too big, so I’m just working
through issue 1 now (although the following issues
are there queuing too). I’m sure I read somewhere
that you wanted feedback on the magazine, so
two things have come to mind.

Firstly, I’ve a growing irritation that almost every
article is KDE-based. I’m a new user (your market),
so I’ve no real idea how interchangeable KDE and
GNOME are, but I know I use GNOME. All the
software so far has been KDE-based, and the only
mention of GNOME I can remember so far was in
the article about customising your desktop, which
went along the lines of “there are two desktops,
GNOME and KDE. In this article, we’ll show you
how to customise KDE.” Useless, then, for me. Is
this a question of balance, or can writers be asked
to consider both, or does this simply reflect that
most people use KDE? (I’ve no idea of their actual
relative popularity). I used GNOME at uni, and
then installed Red Hat 9 at home, and that’s
GNOME too, so we can’t be that rare.

The other thing isn’t a complaint, it’s just to note that
I’m interested in sound—making music, production,
synthesisers, that sort of thing and possibly video too,
when you’re considering subjects for future issues.

Other than that, having got maybe three quarters
through the first issue I’ve a long to-do list (get my
music and photographs organised and so on), so
in that respect it’s a great success. Thanks for it.
--
John

Try Puppy
I read that another Dominican wrote to you in
August, great! Seems like open source is getting
bigger down here!

I just completed the vote for best OS and other
stuff—I chose PCLinuxOS, and I would have cho-
sen Puppy Linux too if it was present, because I
really enjoy it. As a matter of fact, I run both on
my machines, PCLOS on the hard drive, and
Puppy on live CD.

I really recommend Puppy for older hardware. It
works fast! And then you don’t have to be a slave
of the “hardware upgrade cycle”, which is a
major freedom in the computer world!

For the desktop environment, I do really enjoy
GNOME, but I chose KDE because it still feels
more comfortable for me (I fix Windoze PCs for a
living). But then, Puppy runs on fvwm95, and it’s
fine for me.

I wish to thank you for your mag, which is
great. I really read it, and enjoy the advice. 
You guys should cover PCLinuxOS and Puppy
Linux; I am sure that it would interest a lot of
folks. Actually, down here in the Dominican
Republic, most of us are still stuck with older
hardware, so it might help. Keep on going,
you’re doing great!
--
Martin
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Thanks Again, TUX
Thank you! Thank you! Thank you! I can’t thank
you enough for producing a Linux magazine
geared towards new users. I have recently
switched to Linux (PCLinuxOS) after growing more
and more frustrated with spyware, virus infections
and Microsoft proprietary practices. I consider
myself an advanced Windows user, but I really
needed something that would help me learn
Linux, and your magazine is turning into a great
tool for me. I know that it is free, but I would
gladly pay for a print version. Yes, it would be
worth every penny!
--
P3RR1N

Xandros?
I recently purchased Xandros’ Deluxe version. It
hasn’t worked out for me. I thought I should write
to say something about it. I’m composing this on
a Windows e-mail client, because maintenance of
the Xandros product has required so much of me
that I’ve stopped using it.

Xandros has positioned itself as a Windows
replacement. This led me to expect a similar
level of performance. I commend Xandros for
trying, but the performance of their system is
not to this level.

Problems I have experienced come from two
sources. The first is a lack of software perform-
ance. As an example, the CD writing software

crashes frequently. This brings me to the second
problem, technical support. The Deluxe version
comes with 60-days technical support via e-mail. I
wrote the technical support department advising
them of this problem. Following an exchange of
e-mails over a period of weeks they advised me
that they were closing the issue because they
“could not duplicate the problem”.

I’ve had other difficulties as well, and I realized I
was spending more time stewing over the things
in Xandros that I could not get to work than I was
using the system. I’ve returned to using Windows.
And I’m sorry to report that. I think that the
Xandros idea is a good one, but in this user’s view
it’s not ready.
--
David Danforth

Xandros seems to be a Linspire wanna-be.
Perhaps Xandros will be competitive with Linspire
someday, right down to the CNR (click-and-run)
style of installing applications. But right now, I
agree that it falls short.—Ed.

XAMPP Really Works
I’m responding to a Letter to the Editor from read-
er Manish Parmar [August 2005]. Manish was
looking for an easier way to install Apache, MySQL
and PHP on a Mandrake distro. I have certainly
spent a lot of hours trying to get the famous
Apache-MySQL-PHP trio installed and all playing
nicely together. I finally stumbled across XAMPP

(http://www.apachefriends.org/en/xampp.html).
Their Web site states, “XAMPP is an easy-to-
install Apache distribution containing MySQL,
PHP and Perl. XAMPP is really very easy to install
and to use—just download, extract and start.”
And you know what? They are right—it just
works, even for a relative newbie like me.
Everything is configured to work together from
the beginning, and it feels like you are just
installing one package. BTW, I’m running
Mandrake 10.1. Thanks for a great magazine!
--
Gina Bennett

The Simple Things
Request: I am only about five months into my
Linux adventure and so far so good. What I would
like to see are simple things, such as, how do we
“map” a network drive? How do I connect to a
shared printer on someone’s XP Pro computer?
How do I get my Linux workstation to use my
DNS server, which is a Windows 2000 Server?

My first goal of testing Linux at my office is to
make sure I can do all those simple things first
and then work on getting moved over to
OpenOffice.org, Firefox and so on.

Hope these are valid ideas. Love the magazine!
About time someone pulled this type of 
magazine off!
--
Brett Taylor�
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I am perturbed. I like that word. I learned it recently and I am
using it a lot. Perturbed. I am perturbed that my on-and-off
boyfriend Otaku plays Everquest II when he should pay
attention to me.

I am perturbed because I read the last issue of TUX and
see that the editor in chief thinks I have a pathological hatred
of GNOME.

I do not have a pathological hatred of GNOME. I like
GNOME. I like how often GNOME developers change win-
dow managers, desktop designs and user interface ideas. It
is like that guy Forrest says. It is like a box of chocolates.
You update GNOME and you never know what you are
going to get.

I like GNOME because I have no brain. I need GNOME
developers to decide what I can and cannot do with my
desktop. If GNOME made it easy to change the color of the
window title bar and title bar text, I would probably make
both colors white, and then I would not be able to read the
title on my windows and that would make me perturbed.

I like how Nautilus opens ten windows on the desktop at
the same time if I look for a file in different places and
those places are many folders deep. If someday I decide I do
not like so many open windows when I look for a file, I can

move all my folders up to the desktop. It is good to have to
rearrange all your folders to make GNOME easier to use.

I like how Nautilus remembers where I put these windows
and how big they are. It would be hard for me to remember
the last size and position I used for every folder. When I use
KDE, I have to work hard to open so many folder windows.
Then I have to write down the size and position of every
folder window I open. When I visit that folder again, I have
to check my list and resize and move the folder window 
to be the way it was the last time. It is important. I am 
perturbed that KDE does not remember these things auto-
matically. I know you can set KDE to do this, but you can
find out how only if you have a brain, and as I said, I do
not have one.

I like how much the GNOME interface is perturbed and
not consistent. There is a saying, “Variety is the spice of
life.” GNOME is very spicy. I do not even know what kind of
file load and save dialog will come up when I use GNOME
applications. It doesn’t matter. I do not know how to use
most of them anyway. So I give up looking for the file and
that saves me a lot of time I would spend working.

I am not perturbed with this month’s questions. You send
good questions. Send me more. I like them.

Q&A with Mango Parfait
Mango solves a Windows share problem and breaks tradition by answering geek and browser questions and recommending
PlayStation 2 games. MANGO PARFAIT

http://www.tuxmagazine.com


Q I have recently installed Fedora 4 on my Intel box as a
dual-boot with Windows XP. I created a small vfat partition

to share files between [Windows and Linux]. Both OSes boot and
run fine, and the vfat partition is recognized and usable by both
OSes, but there is an ownership issue under Linux. I cannot grant
write permissions to folders or files within the vfat partition
under Linux. As I do not want to work as root, this poses a prob-
lem. I have tried creating folders with different permissions with-
out success. Any suggestions?—Greg Falk

A I have many suggestions. But I should not answer your
question because it is a geeky question. TUX is for desk-

top users, not geeks who know how to make many partitions.
But I will answer your question because your name reminds
me of Peter Falk. I like Peter Falk. I like the movie Princess
Bride and Peter Falk is in Princess Bride. But I also watch many
Columbo reruns.

Now I will tell you my suggestions. My first suggestion is to
play Xenosaga I and Xenosaga II. These are very good games for
PlayStation 2. I am almost perfect as I am, but if I could choose
to look like someone else, I would like to look like KOS-MOS in
Xenosaga, especially Xenosaga II. In the first game, her hair is
plain blue almost like my natural hair color. It is different in
Xenosaga II. The light in her blue hair flows just like the water-
fall in a picture we had at the oriental buffet where I used to
work as a waitress. It is so pretty. I use Action Replay cheats for
PlayStation 2 when I play Xenosaga II. My off-and-on boyfriend
Otaku can play Xenosaga II without cheating. I do not pilot big
robot fighting machines all day like Otaku does, so he plays bet-
ter than I do. I need cheats.

My second suggestion is to get rid of Windows. You do not
need to worry about how to share a partition if you do not have
two operating systems. Delete the stinky one if you have to

delete one of them.
My third suggestion is to treat yourself to ice cream (my

favorite flavor is mango—I am sure you would not guess that),
because you do the right thing. You do not want to run Linux as
root. You want to run Linux as a normal user.

My fourth suggestion is to set up your vfat partition in a dif-
ferent way. Before I tell you how, I want to ask what does vfat
stand for? Very Fat? I like the term Fat32 instead. Fat32 sounds
like the name of a rap group. “Gonna get down make it funky,
gonna paint my crib blue, gonna rap with all my homies ’cause
we’re Fat32.”

Okay, you are probably getting mad at me by now, but I do
this on purpose because you asked a geeky question. But I will
finally give you the real answer. The answer is fstab. Make a
new line in your /etc/fstab file or change the line you have.

Here is something like what you probably have in your fstab
file now. I cannot give you a perfect example. I do not know
what partition you are using. I do not know what mount point
you are using. So I made up the partition /dev/hdb2 and made
up the mount point /shared. You use the vfat partition you
made instead of /dev/hdb2 and use whatever mount point you
want. Here is my example:

/dev/hdb2  /shared vfat defaults 0 0

Here is an example of what you should have in your
/etc/fstab file instead:

/dev/hdb2 /shared vfat uid=greg,gid=greg 0 0

I am making an assumption that your user name and
group name are both called greg. Fedora Core 4 makes a
new group for every user and calls the group the same name
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as the user. If your user name is greg, then your group is
greg unless you changed it. Some other distributions make
“users” the default group. If you (not you, Mr Falk, but you
Mr and Ms Reader) have a distribution that makes the
default group “users”, then you want to put gid=users in
place of gid=greg (or gid=user name).

When you boot Linux, the shared vfat partition belongs to
the user greg and group greg (or whatever user name and
group you put in the /etc/fstab file). You can read and write to
this partition without being root.

But you probably cannot read and write to this partition if
you log in as someone else. If you have many people who use
this computer and you want them to be able to use this parti-
tion, here is what the line should be more like:

/dev/hdb2 /shared vfat noauto,user 0 0

Now the partition is not mounted when you start Linux. A
user has to mount it to use it. This makes the partition and all
the files on the partition belong to the user who mounts it. She
should just type mount /shared from a user prompt, not a root
prompt. She should be polite and do umount /shared when she
is finished so someone else can use it.

Here is a better way. You can use the line that does not
mount the partition automatically, then point and click to mount
and unmount the partition.

Go to the KDE Control Panel or the system settings window.
Select Desktop→Behavior. Click the Device Icons tab. Check the
box for Mounted Disk Volume and Unmounted Disk Volume. If
they are already checked, then you are okay. Leave them
checked. Do this for every user on the computer.

The vfat partition will show up on your KDE desktop. It will
probably look like a disk drive icon when a user logs in. Each

user can right-click on the icon and select mount from the pop-
up menu. She can also right-click on the icon and select
unmount from the pop-up menu when she is done. You can
also change the line in fstab to make the partition belong to a
group that every user can access. How do you do this? It
depends on the distribution, so I will stop now and hope you
are happy with my suggestions.

Q I tried out Opera on the suggestion of the awards person
[see the “2005 TUX Readers’ Choice Awards” in the

September issue] because Firefox can slow down and even freeze
(on Linux!!) my computer, especially with Flash. My problem is
that I cannot get Opera to use Thunderbird (/usr/bin/thunderbird)
no matter what I do! There is very little help on-line. Please
help me!—Samuel James Sarette

A Okay, I make two exceptions this month. First I answer
Falk’s geeky question. Now I will try to answer your

question, even if it is a browser question and not a Linux
desktop question. I hope it will help many Linux users,
because Linux users use Firefox or some other browser
instead of Internet Explorer. There are ways you can use
Internet Explorer on Linux, but I do not recommend any 
of them. I think it is better to use Firefox, Mozilla, Opera 
or Konqueror.

Opera comes with good documentation on how to do what
you want to do. I forgive you for not finding it. It is not your
fault. You won’t find the documentation anywhere in the help
files. I will show you where to find the best documentation
while I show you how to make your settings work.

Select Tools→Preferences from the main menu. Click on the
Programs option on the left side of the dialog and then click the
Advanced tab (Figure 1). Click on the combo box for Email
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application. Change it to Use specific e-mail client.
You should see a field open up. You can type something

in that field. You ask, “What should I type?” That is a good
question. This is when you start looking for documentation.
If you want to waste time, try clicking on the help button.
You will not find the answer. Click on Help→Opera Help
from the main menu and look through the help files. You
will not find the answer. If I am wrong, and Opera put the
answer in the help files, Opera hid the answer or used 
invisible pixels.

Here is how to read the Opera documentation about using
another e-mail client. Point your mouse cursor over the field
that appeared when you told Opera to use another e-mail

client. Wait a while. If nothing happens, move the mouse cur-
sor away and then try again. Someday you will get a tooltip
that tells you how to use this field. I cannot find any other
documentation about how to use this field except this tooltip,
so I am guessing Opera puts all of its documentation in
tooltips. Maybe they will add a “search tooltips” and “index
of tooltips” feature someday.

Enter the following line in the field that opens up:

/usr/bin/thunderbird -compose %w

Some distributions like Debian install Thunderbird as
mozilla-thunderbird, not thunderbird. For those of you who
are not using Fedora, if the line above does not work for
you, try this one:

/usr/bin/mozilla-thunderbird -compose %w

Q I’m using Windows 2000 and SUSE 9.3 Pro, and I want to
share a folder where I have ripped my music collection. I

set the properties in Windows to share the folder, and I have
managed to access it under Linux; however, to access the folder I
have to type ssmmbb::////aatthhlloonn--xxpp//MMuussiicc, and then I’m greeted
with a login prompt. Is there a way to avoid the login prompt,
perhaps by saving the user name and password locally (or even a
setting in Windows)?—Logan Johns

A I am so sorry to read that you ripped your music collection.
You do not give details about where and how it is ripped,

so I cannot tell you how to mend it. Maybe use glue, maybe a
tailor can help. I guess some of your music is still okay, because
you want to share it.

P2P
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I can fix your other problem. Open
the KDE Control Center. If you have a
recent copy of KDE, you can click on
the System icon instead and follow
these same instructions by clicking on
icons instead of lists.

Click on Internet and Network (in the
list on the left in the Control Center, or
the icon if you have the System feature).
Then click on Local Network Browsing.
You can enter a default name and pass-
word here (Figure 2).

Click Apply. If you are using the
Control Center, you can close it now. If
you are using the separate settings win-
dow, click OK to close the window.

Now when you open up a Windows or
Samba share folder, it should open with-

out asking you for a name and password.
I do not have to tell you that this does
not work if you have different names and
passwords for different shares. Because I
do not have to tell you, I do not know
why I did.

Q I am using Firefox as my browser,
and somewhere along the line I

seem to have turned off JavaScript. I
have enabled the selection to run
JavaScript, but I still get problems with:
A) Access to Home Banking—tells me I
need JavaScript enabled. B) Getting some
buttons on Web sites to direct me to
other URLs. The browser just seems to sit
there and do nothing. C) When I open my
home page, it initially opens as a half

screen with what appears to be some
code appearing on the bottom stating:

^  Tooltiptext = "&n

^  label = "&flashgotoNoDMS

Sometimes after a few seconds, the
page fills completely and the code van-
ishes (into the background???).

This also happens on some other sites,
and I have to resize the pane to full screen
manually using the drag function on the
top border.—Alan Nicholson

A Okay, here is another browser ques-
tion. I answered one, so I guess I

will answer another. I hope it helps many
Linux desktop users because many Linux
desktop users use Firefox.

It is possible that your copy of Firefox
is broken or your Firefox settings are bro-
ken. I do not think that is the problem.
Maybe I am right, maybe I am wrong,
and you need to erase your Firefox set-
tings directory and start with new set-
tings. I assume I am right.

Say I am right. Really. Say, “Mango is
right.” It will not fix anything, but it
makes me feel better if you say that. If I
am right, first I will make a guess about
the banking problem you marked “A)”.
Here is the hard way to find out why

P2P
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many pages do silly things like this. Write
a fancy JavaScript thingy for a Web page
and then make it work for every version
of Internet Explorer, Firefox, Mozilla,
Opera and Konqueror, at least. You will
find out very fast why some Web sites tell
you to turn on JavaScript when you know
you have JavaScript on.

If you want a fancy JavaScript thingy
to work on many browsers, you must
write your JavaScript to figure out what
browser someone is using. It depends on
how complicated your thingy is, but you

might have to make little changes for
every browser or even write separate
JavaScript programs for different
browsers—not only different browsers
but different versions of browsers! Some
banks and companies are lazy and they
say, “Everyone uses Internet Explorer so
we do not have to worry if this works on
some other browser.” You go to that
page with Firefox and the page acts
funny or tells you that you need to turn
on JavaScript. I am guessing that is the
answer to your first example.

Now I will make a guess about your
second problem, marked “B)”. You say
that some buttons should take you to
another Web site, but they do not work
for you. I think I can guess this problem
too. Sometimes it is like I said before. The
JavaScript program is stupid about all
browsers except Internet Explorer.

But sometimes the problem is not
the JavaScript code. Open up the
Preferences dialog for Firefox by clicking
Edit→Preferences from the main menu.
Click on the Web Features icon, and you
will see something like Figure 3. Do you
have the box for Block Popup Windows
checked? That could be your problem.
Many JavaScript links and buttons say
they will take you to another place, but
they really open up a pop-up window.

Try this. Uncheck this feature and try
the button again. You know you have
found the problem if the link works.

You do not have to allow all Web
sites to block pop-up windows. You
can see on the Preferences dialog an
Allowed Sites button (see Figure 3
again). Click this button and tell Firefox
on which sites you want pop-ups to
work. See my example in Figure 4.

What if this is not your problem?
Look at one more thing. Click on the
Advanced... button for JavaScript in the
Preferences dialog (see again Figure 3).
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Figure 3. Blocked pop-ups can cause JavaScript problems.
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You will now see another dialog that
looks like Figure 5.

You need to decide what you want to
permit JavaScript to do. I do not want to
recommend any settings. Some settings
let JavaScript do too much. Some settings
stop the JavaScript from doing too much
and make Web pages confused and work
the wrong way.

Now I will make a guess about your
third problem, “C)”. The moon. Sometimes

the moon makes Firefox do funny things.
If it is not the moon, then it might be
Firefox. It might be Firefox and your Flash
plugin. Do you see the question and
answer before yours? Firefox plus Flash
plus Linux sometimes equals crazy like a
Firefox. I have the same problem too on
at least one distribution. After I use
Firefox for a while, I try to load a new
page and it never loads. At first I think my
Internet connection broke. Then I try to
load the same page in Opera or
Konqueror and it loads in one second.

I do not guarantee that the Flash plugin
makes this problem appear. The problem
started after I installed Flash. Maybe it is a
coincidence. Maybe it is not. Try to update

Flash and see if the problem
goes away. Try to uninstall Flash
and see if the problem goes
away. I will do the same thing
and maybe I will let you know
if it solves my Firefox problem.

If none of my advice works
for you, try using Opera 8.02
instead of Firefox. Opera is a
very nice browser. It is free if
you do not care that it shows
ads at the top. [Opera 8.5 is
now available for free, even
without ads.—ED.] It even has

great documentation, if you do not mind
that the best documentation is hidden in
tooltips.

If Opera is not your cup of green tea,
try Konqueror. The bad thing about
Konqueror is you may have more problems
with Web pages than you do with Firefox,
if the Web pages are written mainly for
Internet Explorer. Sometimes you can fix
this by changing how Konqueror identifies
itself. But I am making too many guesses
now, so I will stop here.�

I am a sweet, humble, delicate and very cute genius
who is at your service to answer your Linux questions.
Send your questions to mango@tuxmagazine.com. I
am deeply sorry that I do not have time to respond to
anyone directly by e-mail, but I will select as many
questions as I can and answer them here.
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Figure 4. Define sites where pop-ups are allowed.

Figure 5. Advanced Settings for JavaScript
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Last month, we took a look at performing 
simple editing and photo management tasks 
in KDE’s Readers’ Choice Award-winning digital
photo management application, digiKam
(http://www.digikam.org/Digikam-SPIP). This
month, we look at how to perform similar tasks in
gThumb, the image viewer and browser for the
GNOME desktop (http://gthumb.sourceforge.net).

gThumb has three major view modes, activated
by the first three buttons on the toolbar. The
Folders view mode lets you browse through the
filesystem and shows thumbnails of any images in
the current folder in the right-hand pane. In this

mode, you can perform basic copying, moving,
renaming and deleting of folders.

The Catalogs mode is similar to the Folders
mode. It shows a listing of catalogs in the left-hand
pane and the thumbnails of the images that belong
to a selected catalog on the right. Deleting an
image in this view does not delete it on disk; it sim-
ply removes its association to that particular catalog.

The Image mode can be entered into by click-
ing on the Image toolbar button with an image
selected or by double-clicking on any image,
whether in Catalog or Folder mode. In this mode,
you can see a larger view of your image and are
able to perform various basic editing tasks.

EDITING PHOTOGRAPHS
gThumb comes with a simple range of tools to
touch up photographs. The one feature that is
conspicuously absent is red-eye reduction, but it
has most other basic image-tuning tools. If you
plan to put images on the Web, you’ll want to
make use of the crop and resize tools. Cropping
lets you select only the part of the image you
want to keep and then discard the rest. This way,
you can re-center the elements in a photo or
remove unwanted background objects.

To crop an image, go into the Image mode,
and select Image→Crop from the menu bar.
Select the aspect ratio you want to use from the
drop-down box. In Figure 2, I’m selecting Display,

which is the same aspect ratio as on my screen or
desktop. This makes the cropped image the per-
fect shape for desktop wallpaper. Other choices
are available, or you can select custom to resize
the crop rectangle freely with your mouse.

Use the mouse in the center of the crop area
to position it, and drag the corners with your
mouse to resize it. Once you’re satisfied with your
alterations, click Crop.

My cropped image is now great desktop wall-
paper, but it is a little large for posting on the
Web. If you want to resize an image to make it
smaller for e-mailing or posting on the Web, use
the resize tool found in the Image→Resize menu.

Type the new width you desire into the width
box, and then press the Tab key to have the corre-
sponding height filled in. When you’re finished,
click the Scale button.

If you have a tendency to whip out the camera
and start shooting, without realising you’ve left it on
a preset completely inappropriate to the current light-
ing conditions, you’ll use the color balance tool often.
The cute little guy in Figure 3 was snapped with the
indoor preset left selected—I tend to do that a lot.

DDiiggiittaall  EExxhhiibbiittiioonniissmm,,  PPaarrtt  IIII::  ggTThhuummbb
A look at how to manage and fine-tune photos with gThumb.

JESSICA HALL
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Figure 2. gThumb’s Crop Dialog

Figure 1. gThumb’s Catalog View
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Figure 3. gThumb’s Colour Balance Dialog

To correct the colour balance of an image, go to
Image→Color Balance in the main menu. Figure 4
shows this picture with a little more red and yellow
and a little less cyan and blue. This gives the picture
some warmth and makes it look more natural.

The photograph shown in Figure 5 is my part-
ner Bruce with his newborn cousin, Sam. I didn’t
want to use a flash and make Sam cry, so the
people in the foreground have turned out quite
dark in contrast to the bright sunlight through
the window. gThumb has a brightness and con-
trast tool we can use to tone down an over-
bright picture or brighten up a dark one.

The brightness and contrast tool can be found
by clicking Image→Brightness-Contrast. When
increasing brightness, try also to increase contrast

slightly to retain natural-looking colours and avoid
making the image look washed out.

MANAGING PHOTOGRAPHS
Although gThumb is equipped with basic
image editing tools, its real strength is in its
organisational abilities.

You can sort images into catalogs and tag
them with comments, date, place name and cate-
gory. This meta-data then lets you use gThumb’s
powerful search tool to create dynamic catalogs.

To add a comment, place name or date to an
image, either right-click on the image and select
Comment from the pop-up menu, or select the
image by clicking on it once and then click the
Comment button on the main toolbar when in the
Folder or Catalog view mode. Enter the informa-
tion you’d like to record about the image, and
click Save. Comments and other information about
images are stored in XML files in a .comments
directory in the same directory as the photograph.

To make sure that you always can find the
photograph you want, gThumb lets you sort
images into catalogs. To add a group of images to
a catalog, select them with the mouse and then
right-click on the selection. Choose Add to cata-

log..., and in the dialog that appears, either select
an existing catalog or create a new one using the
New button. Click OK. To see the new catalog
you’ve created, go into the Catalog view mode by
clicking the Catalog button on the toolbar. Images
can belong to more than one catalog.

To fine-tune the sorting of your images fur-
ther, you can create categories with which to tag
your images. To add an image to a category, click
the Categories button on the toolbar with the
image selected or right-click on an image and
select Categories from the pop-up menu. Select
either an already existing category or create a
new one using the New button. You can assign
multiple categories to any image.

This all comes into play when using gThumb’s
extremely powerful dynamic search feature. To
create a new search, click the Find button on the
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Figure 4. Before and After Colour Correction

Figure 5. The Brightness and Contrast Tool

Figure 6. The Comment Editor
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toolbar or select Find from the Edit menu. In
Figure 7, I’m searching for all images that have
the word Auckland in their comment, to try to
find all the pictures taken on a recent holiday.

Click Search, and gThumb shows you all of the
images that match your criteria. You can cancel
the search, further fine-tune it or choose to view
the images it has found. It saves these images as a
dynamic catalog. At any time, you can edit the
search or run it again to gather any images that
have been added that meet the criteria after you
originally ran the search.

Once you’ve assembled a collection of images
you’d like to share with others, gThumb provides a
simple tool to export them to the Web (Figure 9).
Highlight a selection of images with your mouse, and
choose Create A Web Album from the Tools menu.
Tick Copy originals to destination, and then tick
Resize if larger than: and select a size. If you have

friends or family on slow Internet connections, you
might like to make that size as low as 640x480 for
smaller file sizes. Click Save to generate your gallery.

One nice feature of gThumb’s integration with
GNOME is the ability to export catalogs to
Nautilus’ built-in CD-burning support. From the
catalog mode, select Write to CD from the File
menu. When the catalog is opened in Nautilus,
click the Write contents to CD button. Type in a
title for your CD in the Disc name box, and make
sure it has selected the right burner device and a
reasonable write speed (Figure 10).

For more information about gThumb, check
out its Web site at http://gthumb.sourceforge.net
or its comprehensive help manual.�

Jes Hall is a UNIX systems consultant
and KDE developer from New
Zealand. She’s passionate about
helping open-source software bring
life-changing information and tools
to those who would otherwise not
have them.
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Figure 7. The Search Dialog

Figure 8. The Completed Search

Figure 9. The Web Album Creation Tool

Figure 10. CD and DVD Burning with Nautilus
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If you are like me, you like to use a computer to
do as much work for you as is “machinely”
possible. If you are like me, you also carry various
devices with you that leverage all this work you’ve
made your poor PC do on your behalf. This means
carrying a PDA, memory stick or other gadgets
that hold information.

If this description fits you, you probably face
the same situation that I do: accessing all of the
information that you’ve so diligently entered in
one place (like your Linux PC) in other places
(for example, a Windows PC).

Luckily, there is a solution to this problem
for schedules, addresses and to-do lists.
Developer Lutz Rogowski leads a team
(http://www.pi-sync.net) that has taken two
PIM applications from the KDE desktop—
KOrganizer and KAddressbook—and made them
platform-independent. These applications, known
as KDE PIM-PI (KDE Personal Information
Management–Platform-Independent), allow 
a user to use the same programs and data on
Windows or Linux (even handheld Linux, such as
the software run on the Sharp Zaurus PDA). This

article introduces KOrganizer–Platform-Independent
(hereafter KO/Pi); a later article will introduce
KAddressbook Platform-Independent (hereafter
KA/Pi).

The site for the project, called Pi-Sync
(http://www.pi-sync.net), offers the software for
download and installation on Windows XP,
desktop Linux (specifically SUSE Linux 9.2) and
the Sharp Zaurus—on the original Sharp ROM
most all releases and the OpenZaurus ROM
(http://www.openzaurus.org) for stable releases.

INSTALLATION ON LINUX
On Linux, use your package management tool of
choice (YaST, kpackage, Synaptic or whatever) to
install the file KDE-Pim-Pi-X.X.XX-SuSE_9.2.i586.rpm
(where X.X.XX is the version number).

For those who run Debian-based distributions
of Linux (such as Ubuntu/Kubuntu or Libranet),
this page (http://singlenesia.com/software) has
an older but still functional version ready to
install on these systems.

To run, select KO/Pi from your distribution’s K
Menu, or press Alt-F2 and type kopi.

INSTALLATION ON WINDOWS
On Windows, simply unzip the installation file
(kdepim_2.1.16_for_Windows_XP.exe.zip) and
extract the files anywhere you like. However, you
also need to download the file kdepim334dll.zip,
which contains some additional files that the pro-
gram needs on the Windows platform. Unzip this
file to the same folder as you did the previous ones.

To run, go to the folder where you extracted all
of the files, and double-click on kopi.exe to start
the programs. They won’t show up in the Start
menu, because they don’t use the usual Windows
installer that would create shortcuts for them
there (you can do so manually); likewise, they
probably can’t be started from the Run dialog,
unless you use the Browse feature or installed
them to the Program Files directory. In any case, it
is easier to navigate to the folder where you
extracted them and double-click to start.

USING KO/PI
We begin by learning how to use KO/Pi for sched-
ule and task management. On first start, a wizard
prompts the user to enter information such as date

KKDDEE  EEvveerryywwhheerree  YYoouu  GGoo::  
PPllaattffoorrmm--IInnddeeppeennddeenntt  PPeerrssoonnaall
IInnffoorrmmaattiioonn  MMaannaaggeemmeenntt
How to make life easier by using your KDE-based PIM on different platforms.

A. CREG PETERS
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preference (that is, month-first or date-first) and
time zone. It is important to match these carefully
to the date used by the machine you are using. If
your machine uses Windows at all (either alone or
in a dual-boot configuration), it is probably best to
use Local Time. On the other hand, if you use Linux
or other open-source OSes exclusively, these may
set the hardware time of your machine to Grand
Median Time (GMT); if this is the case, set the time
to the time zone in which you reside.

For those who have used KOrganizer, KO/Pi
should look very familiar. It is almost identical in
terms of views available, how the information is
stored and most other aspects. For those who are not
familiar with KOrganizer, Figure 1 shows the basic
layout (Day View) of the program.

[Note: You may notice that some of these

screenshots look dif-
ferent. That is
because some were
taken on a Windows
PC, and some on a
Linux PC. See—it really is platform-independent!]

Click on the button that looks like a calendar
with a week blocked out in blue; this opens the
Week View (Figure 2). In this view, there are a
number of different panels. The upper-left panel
shows the Date Navigator, which lets you jump to
any date quickly. The upper-center panel shows a
list of tasks. The upper-right panel shows the cal-
endars you have loaded (KO/Pi now has the ability
to load multiple calendars—more on this in the
next installment). The To-Do view and the loaded
calendars can be hidden by clicking on the right-

facing arrows. The loaded calendars can be
removed altogether by selecting Toggle Resource
View from the View menu; the Date Navigator
can likewise be removed by selecting Toggle
DateNavigator from that same menu.

The bottom half shows your appointments and
tasks for the week. Depending on whether the
item has a specific due date or time associated, it
appears above or below the date number.
Appointments without any specific time (often
called all-day events) are shown in the box above
each date (as shown in Figure 3). To-dos that are
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Figure 2. Upper Panels in KO/Pi

Figure 1. KO/Pi Day View

Figure 3. Lower Calendar in KO/Pi
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due on a specific day, as well as any overdue tasks you might have,
are shown in those boxes as well. Appointments at specific times
are shown at the bottom, as you would expect in most calendaring
programs. Tasks with deadlines are shown at their assigned times. In
either location, a blue color means the task is pending, yellow indicates the
task is due, red signifies overdue and green means completed.

Let’s begin by adding an appointment. The toolbar at the top has a button
showing a calendar with a small yellow star on it—this is the New Event but-
ton (you also can access it by going to Edit→New Event). Clicking this button
brings up the Edit dialog (Figure 4). The fields in the first tab are self-explana-
tory, allowing you to set the name of the event, the date, the time and
whether you want an alarm. You also can organize your appointments by cat-
egories; select one or more categories from the pull-down menu, or edit the
Categories list by clicking the button and adding or removing them to your
liking. When you’re done, click OK to add the appointment to your calendar
(or click OK+Agenda to take you directly to the day of the appointment).

SYNCHRONIZATION BASICS
Now that you’ve created an appointment, you’ll want to have it available on
all your KO/Pi installations. This process is called synchronization, and it’s one
of the key advantages of the KDE PIM-PI suite. You can set up this function
using the Synchronize menu. Click on Synchronize→Configure to set up your
synchronization.

The dialog box that pops up, shown in Figure 5, is a little confusing at
first. The very top field is labeled Local Device Name. This is a label to
identify your device—you can name it anything you like, as long as all of
the devices have unique names. Under this are three buttons, New Profile,
Clone Profile and Delete Profile. These refer to the Sync Profiles listed in
the pull-down menu below the buttons. You can set up different profiles
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Figure 4. Appointment Edit Dialog

Figure 5. KO/Pi Sync Configuration Dialog (Top)
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depending on where you are and what other
device(s) you are trying to reach. For simplicity’s
sake, let’s create a profile that synchronizes the
event we just created with another, identical file
on the machine you’re using. Click New Profile,
and the Profile Name field shows noName. You
can change this to anything you like; let’s use
Local copy. Scrolling down, you’ll see settings
labeled Multiple Sync Options and Sync Algo
Options (which contains subsections for Sync
Preferences, Filter! Options and Write-back
Options). You needn’t change any of these, as
the defaults are fine for our purposes here.

What will concern you is the next section titled
Profile Kind (Figure 6). There are four options:
Local File, Pi-Sync, Remote File and Mobile Device.

Leave this set to Local File, and go to the bottom
of the dialog. The last section is titled Profile kind
specific settings. There are three input boxes,
which allow you to indicate the local file with
which you want to synchronize KO/Pi, KA/Pi and
PWMgr (this is a password manager application,
which is not covered in this article). You can use
the Choose button to call up a file selector and
select a file, if you have one (KO/Pi uses iCalendar
files, and KA/Pi uses vCard files). If you don’t have
any files, you can input a name, and the applica-
tion creates one for you.

After you are all done with this, click OK to
record your settings. Now, if you click on the
Synchronize menu, there should be an entry for the
profile you just created. Clicking on the profile

name starts the synchronization process. Soon you
should see a dialog box detailing the changes that
the application will make to either or both files (in
this case, only the remote file, because the local file
is the one to which we added the appointment).
Click OK to confirm the changes, and you are fully
synchronized! The good news is that the settings
are shared between KO/Pi and KA/Pi. If you launch
KA/Pi, the synchronization profile should already be
set up for you. Simply begin adding or importing
addresses, and you can sync at will!

Now, you may ask why you would want to
synchronize to another file on your own system.
Instead of the hard drive, these files could be on a
USB memory stick—you can take them to other
places (such as work) and point the KO/Pi you
installed there to synchronize with them. The files
could belong to another program—for example,
the upcoming Mozilla Calendar/Sunbird program
also uses iCalendar files, as does iCal on Mac OS
X (although the iCal files used by KO/Pi may be in
a slightly different in format, and some elements
may not be exactly the same). You can see the
flexibility that KDE PIM-PI offers through its syn-
chronization methods.

In the next article, we will explore the Pi-Sync
protocol and show how two machines with KDE
PIM-PI can synchronize directly with each other.
We’ll also detail some ways of getting data you
already have into KDE PIM-PI, so you don’t have
to enter it yourself. Finally, we’ll discuss some
strategies to make the most of the ability to use
KDE PIM-PI on multiple platforms.�

A. Creg Peters is a project manager at an international consult-
ing firm. In his spare time, he works on fiction, practices kendo
and fiddles incessantly with as many as four Linux machines in
his home in Germantown, Maryland.
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Figure 6. KO/Pi Sync Configuration Dialog (Bottom)
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The elements and principles of design are often
used to teach the basics of general design to
students. This article is the first in a series of
three building on past TUX magazine articles
about Inkscape, an open-source drawing pro-
gram (http://inkscape.org). This series uses the
elements and principles of design to help you
construct compositions.

This introductory piece is geared for all types
of people, from beginners to professionals. It
specifically discusses the elements of two-
dimensional graphic design in order to teach
you a basic design vocabulary. Next month’s arti-
cle will focus on the principles of design that
use the elements you learn from this article. The
third and final article will combine the elements
and principles to help you create a composition
that will be submitted to the Open Clip Art
Library (http://www.openclipart.org).

DESIGN AND GRAPHIC DESIGN
What then is design? In general language, it
often infers an intent or a plan. More specifi-
cally, in the arts, design often refers to graphic
design, which is the art of arranging image and
text to communicate a message. Wikipedia fur-
thers this definition, stating that it is “applied
in any media, such as print, digital media,
motion pictures, animation, product decora-

tion, packaging, and information signs”. It is a
practice that is traced back to the origin of the
written word, yet only in the 19th century did
it receive separate recognition.

Commonly, graphic design is linked with
commercial culture. However, there is nothing
about design that is explicitly linked with 
commodity beyond the long history of use by
businesses to advertise services and promote
products more effectively.

Regardless, to use design effectively, you must
be clear about the message you want to commu-
nicate. What is important to us is how to convey
your intended message more precisely. However,
in order to write, you must first learn vocabulary
(the elements of design), which will enable you to
construct sentences with grammar rules (the prin-
ciples of design). Then, you can write articulate
messages—what are known as compositions in
graphic design.

ELEMENTS OF DESIGN
The elements of design are the basic graphical
components used to create a larger design.
Think of these elements as the smallest units of
design that an artist combines and arranges in
different ways to achieve a design goal. The
common elements are point, line, form (shape),
texture and color.

POINT
A point is a single mark that is placed into a
space. Multiple points can be used to achieve tex-
ture. If grouped together, the human brain con-
nects the cluster of points and draws invisible lines
between the points in space. This effect, closure,
is described later.

First, start Inkscape on your computer. If you
don’t have a copy of Inkscape, point your Web
browser to http://www.inkscape.org and down-
load the proper package for your system—
Windows, Mac OS X or Linux/UNIX. For further
information, please see last month’s article by
Dmitry Kirsanov on getting up to speed with
Inkscape.

To draw points in Inkscape, select the ellipse
tool (F5 key) from the left-hand vertical toolbar (or
press F5, Figure 1).

Then, click on your drawing area and hold
the Shift key down while dragging toward the
bottom right of the canvas. This allows you to
create a small ellipse. Now, go to the menu and
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This follow-up series on Inkscape starts with a serious look at design definitions.

JON PHILLIPS
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select the menu Object→Fill and
Stroke (Figure 2).

Then, change to the selection tool
(F1 key, Figure 3).

Then, select the ellipse you just cre-
ated on the canvas. Next, on the Fill
and Stroke dialog, click the fill tab and
select the flat color button and adjust
the sliders so that the point is black.
Then, select the stroke tab, select the

flat color tab once more, and set the stroke to

black. You now have a point like in Figure 4!
The next step to understanding the point is to

create a cluster of points—the fun part. Now,
select the selection tool (Figure 3, F1 key), and
while dragging the point, press the spacebar to
make a quick duplicate of the shape in a different
location. Make sure not to hold the spacebar
down too long unless you want an unmanageable
amount of copies of your point! Use this technique
to make the outline of a star, or make a cluster of
points in the corner as shown in Figure 4.

LINE
A line is a mark with length and direction. It is cre-
ated by a point that moves across a surface. A line
can vary in length, width, direction, curvature and
color. It can be two-dimensional, like a pencil line
on paper, and also can imply three-dimensionality
to create perspective. Lines can be grouped
together to create a sense of
value, density and texture.

In Inkscape, select the
beziér curve tool from the
left-hand toolbar (Shift-F6,
Figure 5).

On the canvas, single-click
your mouse. Then, move to
another location and double-
click, thus ending your line. 

Next, single-click while holding down the Ctrl
key. While pressing that key, move your mouse to
the right keeping a straight horizontal line. Double-
click to terminate the line. Then, use the technique
learned above to make three quick duplicates
below this newly created horizontal line.

Select the first newly duplicated line with the
selection tool and then select the stroke style tab
on the Fill and Stroke dialog. Change the Width
of the line to 3 points (pt), as shown in Figure 6.
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Figure 2. The Fill and Stroke Dialog

Figure 4. What’s the Point?

Figure 3.
Selection
Tool

Figure 5. Beziér
Tool

Figure 6. The Stroke Style Tab in the Fill and
Stroke Dialog

http://www.tuxmagazine.com


Select the line directly below this 3-pt line, and
change its width to 6 points. Then, select the
fourth line, change its width to 15 points, and in
the fill and stroke dialog, change the dashes to
the second option from the top in the pop-up list.
You now have a large dashed line (Figure 7).

Lines also can be curved and irregular. To
make a curved line, click on the canvas once
more with the beziér tool, and this time continue
to hold the mouse button down and drag
toward the bottom-right corner of the drawing
area and let go. To terminate that line, double-
click. This is a curved line. To make an irregular
line, click once on the canvas and move your
mouse to another location, click again, move to
another location and then double-click your first
mouse button to terminate the line. This makes a
shape similar to the bottom-right corner image
in Figure 7.

FORM (SHAPE)
The simplest definition of form, or shape, is a
closed contour, an element defined by its perimeter
(http://digital-web.com/articles/elements_of_design).
This is a flat figure or shape that is created when
actual or implied lines meet to surround a space.
Often a change in color or shading helps to
define a shape. There are generally geometric
and organic shape types. Geometric shapes are
constituted by the primary shape types—circle,
rectangle and triangle—in addition to multi-sided
polygons. Organic shapes have irregular outlines
composed of straight and curved lines.

Now that you have learned how to create irregu-
lar lines, it is a simple matter of closing one of these
lines to make it a closed shape. Use the beziér tool
to construct a square by using the Ctrl key to con-
strain the lines horizontally and vertically. When
approaching the end of the fourth line that makes
the square, let go of the Ctrl key and move your
mouse over the small box that is now on top of your
initial click. Once your mouse is in this box and it
turns red, let go of your mouse. You have now creat-
ed an approximate square, as shown in Figure 11.

As an aside, another way to create this same
shape is to select the rectangle tool (F4 key, Figure
8). Click once and then drag down and right to
create a basic rectangular shape.

Now, to create a geometric shape, select the
polygon tool (* key, Figure 9).

Click in the middle of your canvas, hold the Ctrl
key and drag upward to create, by default, a five-
pointed polygon, also called a star (Figure 11). If you
would like to change the number of sides on your

polygon, go to the auxiliary toolbar above the can-
vas and change the number of corners with the up
and down arrows next to the entry box (Figure 10).

To create an organic shape, create another
polygon and then go to the auxiliary toolbar
(Figure 10) and change the number of corners to
four and the Rounded value to 0.60. You have
now created an organic shape (Figure 11).

TEXTURE
A texture is used to create the appearance of a sur-
face, or the material that composes something. It is
the way a surface feels—how it may look. Example
descriptions of textures are rough, bumpy or smooth.

In the point exercise, we created a cluster of
points that approximated some type of surface. For
this demonstration, let’s use line segments to create
the effect of texture. First, create a simple line. Then,
quick-duplicate several times with the same distance
between duplicates as demonstrated in Figure 13.
Cover a large area of the canvas using this technique.

Next, create a line that is perpendicular to the
first line you created. Use the same procedure of
quick-duplication to make a cross-hatched effect.
This increases the density of the texture.

If you want to increase the line’s length and
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keep its direction the same, change to the
Edit tool (F2 key, Figure 12).

Then, select one of the cloned lines,
select an end point, hold the Alt and Ctrl
keys, and drag the point upward or down-
ward. The direction of the line is now con-
strained. Using this technique, you can make
a texture fill an irregular or organic shape
(Figure 13).

COLOR
Color is the perceived character of a sur-
face according to the wavelength of light
it reflects. Color has three dimensions:
hue, value and intensity. Hue is another
word for color and is indicated by common
names like red or blue. Value is variable
from lightness (white) to darkness (black),
and intensity is a color’s brightness (chro-
ma) or dullness (gray).

Now, using the shape example, let’s
add some color. To begin, select the first
rectangular shape and then go to the Fill
and Stroke dialog and select the Fill tab.
Make sure that the flat color button is
depressed. Also, make sure the RGB tab is
selected. Adjust the red, green and blue
values to achieve a color like the first
shape in Figure 16.

Select the second shape, the star, and
change its color to yellow. Then, select the
Stroke paint tab in the Fill and Stroke dialog
and select the flat color button once more.
Now, change the stroke color to red. Also,
increase the width of the line to 6 points like
you did in the line section and make sure, in
that same dialog, that the line is not dashed.

Next, select the third object, the

organic four-pronged object. Click the Fill
tab in the Fill and Stroke dialog and select
the linear gradient button to the right of
the flat color button. Your selection now
by default is a linear gradient that
changes gradually from the last selected
color (yellow) to no color. To change the
gradient colors, click the Edit... button on
the Fill and Stroke dialog (Figure 14),
which pops up a Gradient Editor dialog
(Figure 15). Change each stop to the col-
ors you would like. For this exercise, try to
match the colors in Figure 16. Then,
make the stroke color of this object into a
gradient matching Figure 16’s stroke
color. Make sure to change the stroke
width to 6 points and make the line solid,
not dashed.

CONCLUSION
You have now successfully graduated basic
design vocabulary school! In the next
installment of the series, we will learn the
basic grammar of design, the principles of
design: balance, rhythm, proportion, domi-
nance, unity and composition.�

Jon Phillips
(http://www.rejon.org) is an
open-source developer, artist
and scholar with 12+ years of
experience building commu-
nities and working within
computing culture. He is cur-
rently developing Inkscape,

the Open Source Project the Open Clip Art Library
(http://www.openclipart.org), teaches at San Francisco
Art Institute (http://www.sfai.edu) and now works for
Creative Commons (http://www.creativecommons.org).
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Figure 16. Finally, Color!
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Managing personal finances becomes significantly
more complicated as we age. We initially deal only
with smaller amounts of pocket money and have
very little accountability for what we do with it. By
the time we enter the work force, our needs
increase and we start having to pay for gas, rent,
books and so on. Once we reach adulthood, the
amount of transactions that we perform every day
becomes too high to track simply with a spread-
sheet. We want to track not only of our paychecks,
but we also want to keep an eye on our taxes,
retirement funds, home mortgages, lines of credit,
credit cards—the list goes on.

GnuCash is a finance management application
that uses formal accounting principles to help you
keep track of where your money comes from and
where it goes. In turn, the data you maintain
through GnuCash allows you to perform some
thorough budgeting and lets you identify problem
areas in how you currently manage your money.

ACCOUNTING AND THE GNUCASH TUTORIAL
I don’t know about you, but when I went to col-
lege, I took accounting and could not stand it. All
the concepts were boring and unnecessarily com-
plicated. So I went on with my life and slowly for-
got every single concept of accounting that was
ever taught to me.

I realized several years ago that personal
finance applications, such as GnuCash, provide a

way to track and manage my money, but I was
intimidated by such applications shortly after
starting them every time, mostly because of the
dreaded accounting principles I had forgotten so
long ago.

I will say it flat out: the most exciting aspect
of GnuCash from my perspective is its excellent
documentation.

GnuCash ships with documentation about
each feature provided by the application, but it
also includes a “Tutorial and Concepts Guide”
that does an amazing job of explaining the
concepts of accounting and also puts them in
perspective. The tutorial helps you relate all the
concepts to your everyday transactions and

explains in a practical way how GnuCash
approaches each problem.

After spending a little while reading the tuto-
rial and following along with the example sce-
nario, I started looking at GnuCash in a different
way. It took me a while to get used to the user
interface of the application, but the tutorial
always pointed me in the right direction when I
started feeling frustrated.

PERSONAL FINANCES VS. SPREADSHEETS
Last month in TUX, we spent some time looking
at how our friend Adam used OpenOffice.org
Calc to manage his budget. His financial spread-
sheet allowed him to enter recurrent transactions,
basic accounts and use customized formulas to
determine what was happening to his money.

The spreadsheet model is a good tool if you
are looking for a high-level overview of the num-
bers that matter to you today, but this model does
not scale well.

Our friend Adam realized that as well. As
Junior accountant, Adam did not need to read the
GnuCash tutorial to get up to speed on his
accounting concepts, but he did spend some time
reading it anyway just to see how these concepts
applied to GnuCash.

ADAM IS BACK
Adam recently decided to stop renting his current

GGnnuuCCaasshh
Looking for something like Quicken on Linux? Here’s how to use GnuCash to handle your finances.

XAVIER SPRIET

Figure 1. Tutorial and Concepts Guide
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apartment and purchase his first home. He needs
to determine where his money is coming from,
where it is spent and how much money he
should consider spending per week to make his
mortgage payments without having to sacrifice 
his lifestyle.

Once he knows how much money he can
afford to spend per week, Adam can start look-
ing in his inbox and sign up for that perfect
pre-approved mortgage at an incredible rate
sent by an emerging bank that has nothing in
mind but the well being of random e-mail
users. Either that or he will decide to hunt for a
real mortgage.

ACCOUNTS
In order to keep track of his money, Adam needs to create five general
accounts under GnuCash. He launches GnuCash and completely skips the
usual tip-of-the-day window as well as the first-time configuration druid that
offers to create some base accounts for him. He then proceeds to create his
main account containers:

� Assets: the assets account allows Adam to keep track of what he owns.
This includes cash, goods (cars, homes and high-value items), stocks,
mutual funds and so forth.

� Liabilities: Adam needs to monitor his liabilities to keep track of what he
owes. All types of debt are managed as liability accounts.

� Income: income accounts bring additional value to Adam’s net worth.
Every week, his paycheck increases the balance of his checking account
(asset). This transaction originates from his main Income account.

� Expenses: Adam creates one sub-account under the Expenses account
for each category of expense that he typically deals with. This includes
his phone and utility bill, the taxes that come out of his salary, his rent
and so on.

� Equity: equity accounts are used to track Adam’s net worth. We create
only one equity account at first and use it to track the original balances of
other accounts. This is important, because you do not typically start using
a financial application with zero money, income or debt.

For each of these top-level accounts, GnuCash provides a matching type
of account. It is important to set the type of account properly when you cre-
ate a new account, because GnuCash uses this type to determine how the
money should flow between accounts.
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SUB-ACCOUNTS
Adam now needs to enter his individual sub-
accounts into these containers. This part is rela-
tively easy; the only trick is to make sure you
select the appropriate type of account for each
new account you create. The GnuCash tutorial
does a great job of describing the function and
purpose of each type of account available to you.

Under the Assets account, Adam creates the
following sub-accounts:

� Checking (that is, Adam’s checking account).

� Savings (Adam’s saving account).

� Retirement contributions (Adam is Canadian, so
he contributes monthly to his RRSP account for
his retirement).

Under the Liabilities account, Adam now needs
to create the following sub-accounts:

� Line of Credit: Adam uses a low-interest per-
sonal line of credit to benefit from lower inter-
est rates on his credit purchases by paying his
credit card immediately after each expense with
his line of credit.

� MasterCard: Adam frequently uses this credit
card for large purchases when he does not
want to face instability on his checking
account balance.

Under the Income account, a simple Salary
account is used to track Adam’s only source 
of income.

Under the Expenses account, Adam creates an
expense account for his phone bill, long-distance

plan, rent, income taxes, groceries, utilities, cell
phone, Internet service, gas and a general enter-
tainment account.

The Equity account has only one sub-account
called Opening Balances that is used to assign bal-
ances to the newly created accounts.

TRANSACTIONS
Now that Adam’s base accounts are all in
place, he can start using GnuCash to record
individual transactions. The first transaction

Adam wants to record is the
opening balance for each of
his accounts.

Adam double-clicks on his
Checking account, clicks on the
first available transaction line to
create a new transaction and
enters Opening Balance as the
description of the transaction.
He then selects Equity:Opening
Balances as the transfer account,
and enters the amount of 100 in
the deposit column. When
Adam presses the Enter key or
clicks the Enter button on the
toolbar, his transaction is creat-
ed. The balance of his checking
account is automatically
changed to 100, and so is his
Equity:Opening Balances
account, thus indicating Adam’s
current net worth is $100.

Following this model, Adam
creates transactions for each of
his expenses. When creating an
expense transaction (for exam-
ple, Rent), Adam needs to use

the withdrawal column for the amount of the
transaction, as the money is actually being taken
out of his checking account and transferred to
his Rent expense account.

Because bills typically are sent on the first
day of the month and are due by the last day
of the month, Adam makes the date of each of
his recurrent expense transactions the first day
of the next month, that way his current bal-
ance is not affected by bills that have not yet
been received.
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COMPLEX TRANSACTIONS
Adam almost had a heart attack once he saw his
balance forecast after entering all his expense
transactions. He then realized that he had not yet
created any transaction for his income.

Adam’s weekly salary entry is a little more
complex than the other transactions he has just
set up.

Every week, Adam receives his paycheck. This
paycheck is calculated by dividing his yearly salary
by 52 (the number of weeks during the year),
then income taxes are automatically paid to the
government (roughly 30% of Adam’s income) and
Adam’s retirement contributions to his RRSP
account also are transferred automatically (roughly
$20 per week).

If you have followed my advice and read the
GnuCash tutorial, you already should know how
we are going to manage this complex transaction.

GnuCash offers support for transaction con-
tainers called splits. A split lets you create a group
of transactions that are dependent on each other
and the transaction group in general.

Adam double-clicks on his Checking Account
entry in his Assets account, clicks on an empty line
to create a new transaction and clicks on the Split
button in the register’s toolbar. Immediately, some
nested transaction lines appear, indicating
GnuCash is ready to record the details of his
transactions group.

In the Description field, he enters the value

Weekly Paycheck. Without even specifying a value
for the transaction, Adam selects the first nested
line, and without entering a description, he selects
the Income:Salary as the transfer account.

Adam makes roughly $60,000 a year, so in the
Withdrawal column for the new nested transac-
tion, he enters 60000/52 and GnuCash automati-
cally calculates Adam’s gross weekly salary.

Now, because he must deduct taxes, Adam
selects the next nested transaction line, skips the
description field again, selects the account
Expenses: Income Taxes and enters 60000/52*.33
as the value under the deposit column to indicate
this amount will be deposited from his checking
account to his taxes account when the group of
transactions is processed.

Now, for the RRSP contributions, Adam simply
has to create another nested transaction that
deposits $20 to his RRSP account (an Assets
account).

Upon pressing Enter, Adam’s split transaction is
recorded and the register shows the balance of
the transaction, which should hopefully be posi-
tive; otherwise, Adam needs to move to a differ-
ent country or find another job.

SCHEDULING TRANSACTIONS
Now that Adam has created a split transaction to
record his next paycheck, he is wondering how he
can avoid creating this transaction again every
month. Fortunately for Adam, GnuCash supports

transaction scheduling and recurrent transactions.
Scheduling a transaction is pretty easy. All

Adam needs to do is double-click on his Checking
Account entry, select the transaction he wants to
schedule and click on the Schedule button in the
toolbar. An assistant shows up, prompting him for
information pertaining to the schedule he wants
to create.

Adam selects Weekly for the frequency of the
transaction, selects next Friday as the start date
and Never Ends as the end data. Once he records
the transaction, it is stored as a recurrent transac-
tion.

This does not mean that GnuCash automatical-
ly enters the next X transactions automatically for
you in your register. Instead, scheduling a transac-
tion works by having GnuCash check for sched-
uled transactions at startup or during runtime and
prompts you to create the transaction automati-
cally.

Every Friday, GnuCash now prompts Adam to
record his latest paycheck. Simply following the
wizard instructions allows the transaction to be
created automatically without any calculations
required on Adam’s side.

REPORTING
At this point, Adam has entered enough informa-
tion to generate reports that will show him what
is happening to his hard-earned money.

The first report Adam wants to see is the
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Account Summary report. He does this by clicking
on the Reports menu entry and selecting the
Account Summary entry from this menu.

Once the report shows up, Adam can change
the settings GnuCash used to generate that report
by clicking the Options button. In the dialog that
appears, Adam wants to select the last day of
next month as the report’s end date. He now is
able to have an accurate forecast of his financial
shape by next month, with all transactions being
processed automatically and broken down as part
of the report.

Now that Adam has a high-level overview of
his money’s whereabouts, he wants to drill-down

into the accounts and forecast on a per-transac-
tion level. He creates a new Transaction Report
and sets the end date as the last day of the fol-
lowing month again and sees a breakdown of all
the transactions that have occurred since the start
date of the report and up to the last day of the
following month.

Adam’s wife is not an accountant, and she
could care less how individual transactions affect
her bottom line. All she wants to know is how
much money is coming in and how much is going
out. Fortunately for Adam, the Cash Flow report
allows him to do exactly that.

You can discover the other reports provided by
GnuCash as you go. I have had little success with
most of the graph-based reports as they failed to
display any kind of legend on both of my test
configurations. You should be able to create and
configure most reports with ease at this point.

MORE FEATURES
GnuCash provides a very large number of features
that we did not have space to cover in one article.
For example, the Reconcile feature allows the
accountant to compare the recorded amount of
each transaction with the amount found in the
bank statement. This lets you track inaccuracies or
lost money. Adam uses this feature at work for his
corporate account needs, but he does not feel this
feature is very important to him for managing his
personal finances, so you can read up on this fea-
ture in the GnuCash tutorial as it is also very well
documented.

GnuCash also provides a Mortgage Payment
wizard that lets you enter the attributes of your
mortgage and have GnuCash come up with a

payment schedule and also enter the scheduled
transactions.

This feature seemed to have issues dealing
with weekly mortgage payments, so Adam decid-
ed to rely on the mortgage schedule provided by
his bank instead.

INSTALLATION
GnuCash has been around for a long time, and it
is available for every distribution I have ever heard
of to date. Under Fedora/Red Hat, you should be
able to type yum install gnucash. Similarly, on a
Debian, Ubuntu or any other Debian variant, you
should be able to type apt-get install gnucash
to install the application.

� Under Gentoo Linux, type emerge gnucash.

� Under Mandrake/Mandriva, type urpmi
GnuCash.

For most other cases, you should be able to
use the package manager shipped with your dis-
tribution (SUSE and Novell Linux also ship with an
automated package manager). If your distribution
does not provide a package management system,
you should be able to find a version of GnuCash
on your distribution’s media.�

Xavier Spriet is a software architect
at Netmon, Inc., in Windsor, Ontario.
He is an avid reader and enjoys bik-
ing and traveling. You can reach
Xavier at xavier@wuug.org.

TUX EXPLAINS

38www.tuxmagazine.com

Figure 7. Cash Flow Report

mailto:xavier@wuug.org
http://www.tuxmagazine.com


TUX EXPLAINS

39www.tuxmagazine.com

iRiver is a portable media player. It isn’t quite
accurate to call it an MP3 player, because iRiver is
one of the few so-called MP3 players that sup-
ports the OGG/Vorbis music format. When you
add to that the awesome sound quality it pro-
duces (with the included Sennheisser head-
phones), it makes it a great choice for the Linux-
using music lover.

The only problem with iRiver is that it doesn’t
work out of the box with Linux, which shouldn’t
be much of a surprise really, as Linux is infamous
for poor driver support. Fortunately, the problem
is easy to solve. And in this article, I show you
how to solve it. So let’s start cracking!

ONE WAY IN—TWO WAYS OUT
The first step is figuring out how you want your
iRiver to behave. Don’t know what I’m talking
about, do you? Well, just follow my lead, it’s not
difficult at all. The firmware (software embedded
in a hardware device) that came on your iRiver
doesn’t make it behave as a UMS (USB Mass
Storage) device. If it did, you could use it as a nor-
mal USB disk. But don’t despair! It is possible to
turn it into a USB disk by upgrading the firmware.

It’s up to you to decide whether you want to
do this to your iRiver device. If you want to keep
the firmware as it is, you’ll have to connect your
iRiver to your computer using special software.
The up-side of this is that you won’t have to

upgrade the firmware that lets you view the radio
station presets and view the remaining battery
power from the computer. The serious down-side
is that you won’t be able to use it as a UMS
device and thus will need the special software
installed on every computer you want to use with
your iRiver. Finally, you can’t copy your MP3s from
your iRiver to the computer’s hard drive because
of the official firmware’s built-in restrictions.

The alternative, again, is to change the (offi-
cial) firmware to unofficial firmware. This changes
your iRiver into a normal UMS device unhindered
by copying restrictions, so you can carry around
and use your iRiver with any computer that has a
working USB port. The down-side is that you can-
not use the custom iRiver software with your
iRiver device anymore.

I chose to switch to the UMS firmware. It is
more useful to be able to see the battery meter
and radio station presets on the device itself than
to view them on a computer. Plus, it is nice to be
able to use such a device as a disk. It makes it
easier to use as a music device and makes the
iRiver an all-purpose portable disk drive.

If you decide to turn the iRiver into a UMS
device, jump to the “Using UMS Firmware” sec-
tion; otherwise, just continue reading.

LEAVING THE FIRMWARE AS IS
As mentioned, you can use your out-of-the-box

iRiver pretty much exactly like you would if you
were using the official iRiver software.

What you need to connect iRiver to the com-
puter is a working USB port and a package called
libusb, or a package similarly named. Most distri-
butions come with full USB support built-in nowa-
days, so you probably don’t have to worry about
installing this package.

GOING OLD-SCHOOL WITH IFP-LINE
ifp-line is a simple command-line application
with which you can browse and manipulate files
on your iRiver (upload, download and remove).
It is capable of checking the battery, formatting
and upgrading the firmware. But what’s even
better is that it can be used together with
Midnight Commander to make the file manipu-
lation a lot easier. And this is what we try to
accomplish here. For those who desperately
want to learn its command-line commands, the
README is pretty straightforward.

Install ifp-line. It should be available for your
distribution as a package. If not, have a techie
friend compile it for you. If you know how to
compile programs, uncompress the tarball, change
to the ifp source directory and run:

# make; make install

If you want to use ifp-line as a non-root user,

II’’vvee  GGoott  PPeeaaccee  LLiikkee  aann  iiRRiivveerr
TUX walks you through how to set up an iRiver device on your Linux system.

MATIJA SUKLJE
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you also should run the following command in
the same directory:

# ./noroot.sh

Now, we’re set. You can test whether it works
by simply plugging the iRiver in to a USB port,
turning it on and running these commands:

# ifp ls
# ifp df

The first command should show you which
files and folders are on the root directory of your
iRiver, and the second should tell you how much
free space you still have on your iRiver (in bytes).

WORKS? GREAT! NOW, LET THE REAL 
FUN BEGIN!
There are some graphical applications available
for iRiver. Since I’m a KDE user, I cover the
installation and usage of the Qt-based ifpgui.
GNOME users might be happy to hear there’s
also iFP-gnome (see Resources)—a GUI made for
their favourite desktop.

You should be able to find a package of ifpgui
for your distribution, but if not, it is even simpler
to compile than ifp-line. Tell a techie friend to
uncompress the source code tarball, change into
the ifpgui directory and run the command:

$ ./build.sh

It asks you for the root password once during
the install to make the application usable by
non-root users.

As you can see in Figure 1, the interface is
divided into four sections: the menu bar, the info
bar, the button area and the main area. The
main area is also divided into two parts. The left

part shows the files on your computer, and the
right part shows files on the iRiver. The buttons
are self-explanatory.

The first thing you might want to do is dive
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Figure 1. The ifpgui Main Window
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directly into copying music to your iRiver.
The interface is simple to understand,
but if you would like to hear how to do
it, here’s how. Let’s say you want to
upload some rock albums and keep them
separated from the rest. So, create a
new directory using the right-click menu
on the right (that is, iRiver) part of the
main area, create a new folder and name
it Rock. Enter that new folder you just
created. Now, navigate to your favourite
rock songs on your computer (left part of
the main area), select them and press the
Upload button. You also can upload the
files simply by dragging and dropping
them from the left area to the right—
whatever suits you best. You can select
multiple files if you hold down the Ctrl
key while clicking on them.

While you’re at it, you might as well
add your favourite radio station. Simply
click on the radio button (it’s the right-
most button) and change the presets.
Let’s say you want to add a radio station
called foo at the frequency 89.45MHz
on the first preset. Double-click the
Frequency field in the first row, and
enter 89.45. You can even name it (it

doesn’t show on the iRiver though) by double-clicking the Station field
and typing in foo.

But, as already mentioned, this application isn’t difficult to use at all,
just play with it a bit and you’ll understand it perfectly. Unfortunately,
ifpgui is, at the time of this writing, still in the beta phase and gave me
problems detecting the connection to the iRiver. It may work for you
immediately by the time you read this.

USING NEW UMS FIRMWARE
In my experience, iRiver becomes a lot easier to use when you transform it
into a UMS device; it behaves just like a normal USB disk.

It is fairly painless to update the firmware to the UMS version. Download
the latest UMS firmware from the official iRiver home page, and unzip the
file with the command:

$ unzip <firmware filename, such as IFP-800T.HEX>

If you prefer to use your KDE desktop, simply open the zip file by clicking
on it. KDE opens the file as if it were another folder. Now drag the file to a
convenient location, like the desktop, to unzip the file.

If you’re a command-line friendly person, run the following command to
update the firmware:

$ ifp firmupdate <firmware filename, such as IFP-800T.HEX>

It’s even easier if you use ifpgui. Click the upgrade firmware button, and
select the .hex file you downloaded and unzipped to the desktop.

After the upgrade has finished, simply turn your iRiver on again, and
you can start using it after it is done reformatting itself. Some distribu-
tions will detect the device automatically when you plug it in and turn it
on. KDE will place an icon on the desktop for you. If your distribution
doesn’t work that way, put a link to it on your desktop yourself. Right-
click on the desktop (while it’s plugged in and turned on) and select
Create New→Link to Device→Hard Disc Device. Be sure to point the
device to the right device (usually /dev/sda) and change the icon and the
name to what you like best.

Now that you can access your iRiver from your desktop, you don’t
have to mount it manually every time—just plug the iRiver in, turn it on
and click its icon. Now you can open another Konqueror, point it to your
music collection and drag and drop your music files from there to your
iRiver. But, don’t forget to unmount before you unplug it! Because you
have a device link on your desktop, that’s as easy as right-clicking the
icon and selecting Unmount.
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SOME EXTRA GEMS
If you are using KDE 3.4, you can run Konqueror and enter media:/ in the
location field. Here’s an even easier method: press Alt-F2. A dialog box
appears. Type media:/ in the edit field, and click the Run button.

amaroK is a popular music player for KDE. amaroK users might like to
upload their music directly from amaroK to their iRiver. Select Tools→Script
Manager from the main menu, after which a dialog box should appear. Click
on the Get More Scripts button. A new window should appear with a list of
available scripts. Select the one called Transfer To Media Device and click on
the Install button. Then click Close to close the script installation window.

Now you need to configure this script. Select Tools→Script Manager
from the main menu if you closed the Script Manager window. Select

transfer_to_media_device.sh from the Scripts list, and start the
script by pressing the Start button. (Depending on the size of
the scripts window, you may see only a portion of the name
transfer_to_media_device.sh.) Click the Run button. Then, click

the Configure button. Click on the Storage Media option on the
left and select the iRiver device. If you have an older version of

KDE, you can navigate to the mount point, usually /media/usbdisk.
Now you can upload tracks directly by right-clicking the selected tracks

and selecting Transfer to→USB device. If you would like to have this amaroK
script load itself every time you (re)start amaroK, tick the Start scripts on
application startup box.�

Matija Suklje is a 21-year-old law student from Ljubljana, Slovenia, who
has been interested in Linux and F(L)OSS since his early high-school days.
You can contact him by e-mailing matija.suklje@rutka.net or from his
new home page (http://matija.suklje.name).
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Figure 3. The amaroK Script Manager

RESOURCES

iRiver Official Home Page: http://www.iriver.com

ifp-line (Command-Line Application): 
http://ifp-driver.sourceforge.net/ifp-line

ifpgui (Qt/KDE GUI): http://ifpgui.sourceforge.net

iFP-gnome (GTK/GNOME GUI): http://ifp-gnome.sourceforge.net

transfer_to_media_device amaroK Plugin: 
http://www.kde-apps.org/content/show.php?content=26850

Rockbox (Alternative/Unofficial Firmware):
http://www.rockbox.org

http://matija.suklje.name
http://www.iriver.com
http://ifp-driver.sourceforge.net/ifp-line
http://ifpgui.sourceforge.net
http://ifp-gnome.sourceforge.net
http://www.kde-apps.org/content/show.php?content=26850
http://www.rockbox.org
mailto:matija.suklje@rutka.net
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About a year ago, I realized that there was only
one reason I still had Windows installed on any of
my systems. I’m a gamer; I admit it. So for a very
good reason, I just had to have Windows—or so I
thought. A few months after my epiphany, I read
all the hype about WineX, which later became
Cedega. I’ve been using Cedega ever since, and I
must say that it keeps up with what I want to do
and then some.

First off, it should be known that Cedega is not a
complete Windows environment, or anything near
it. It allows you to run Windows games on Linux.

Second, I need to address the payment
issue. Cedega costs $5 US a month with a
three-month minimum, and to me, it was
worth it to spend $15 to see if I could get
away from Windows. As Linux users, we’ve
been quite spoiled in that we get great soft-
ware for free (as in beer). Although you can
download the most current version of Cedega
without paying for it, this version does not
include the .dll files or licensed material (think
copy protection) that you need to run games.
Besides, it’s worth paying a small fee to rid
yourself of the anchor and not have to dual

boot. Also, you get to influence the Cedega
developers and voice what’s important to you;
the developers actually do listen to user requests.

Cedega does not work with every game, so
it is really important to make sure it’s going to
do what you need it to do. Your first stop
should be http://transgaming.org/gamesdb, the
games database for Cedega. This database
shows the level of support for every game that
someone has thought to test with Cedega.
Check the database to see what the playability
level (not the popularity level) is for the game
you’d like to play. If the playability level is any-
thing but a 4 or 5, it’s not likely to act like it
would on Windows. So if your favorite games
all have lower playability levels, Cedega proba-
bly isn’t for you. There are some exceptions
where a playability level is 3, but the game
plays fine. Another thing to keep in mind is
that older games might start to work on newer
versions of Cedega, but if nobody tests it
again, the playability level in the database
won’t be adjusted accordingly.

The playability levels and their definitions
are listed below. These definitions were hard to

find, and I encountered many conflicting
sources of information, but this should give
you an idea of what they mean. You can safely
assume that if the playability is a 4 or a 5,
you’ll be satisfied with how the game works in
Cedega. However, you will find only the games
officially supported by the TransGaming team
at the URL http://digital-conquest.ath.cx/wiki/
index.php/Category:Supported. Here are the
playability levels and their definitions:

� 0 or N/A: Not rated.

� 1: Game does not install.

� 2: Game installs, but it does not play at all.

� 3: Game installs and plays, but it is limited in
function.

� 4: Game installs and plays, but there are minor
problems.

� 5: Game acts exactly as it would on a Windows
system.

PPllaayyiinngg  WWiinnddoowwss  GGaammeess
oonn  LLiinnuuxx  wwiitthh  CCeeddeeggaa
How to use Cedega to play your Windows games on Linux.

KEVIN BROWN
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Once you’ve signed up, getting Cedega
going is remarkably easy, especially since

TransGaming has now written a program that
does almost everything for you. This program is

called Point2Play. You’ll need to log in with
your new account to download the appropriate
software. Once you’ve logged in, click on the
Downloads link. Read and decide whether you
want to agree to accept the license.

Once you’ve done that, you should have
access to many different files. Download the
most recent version of Point2Play. Download
either an RPM, Debian Package or tarball
depending on which type of file your system
uses. My SUSE 9.3 system is RPM-based, so I
chose to download the RPM. They also have
packages that let more experienced users save
download time. When in doubt, however,
choose a full package. These include everything
you need.

Install the software you downloaded, and
you should see a new icon appear in your K
Menu or GNOME menu. If for some reason an
icon doesn’t show up on your particlar Linux
distribution, you can start any program in KDE
or GNOME by pressing Alt-F2. Enter the com-
mand Point2Play, and press Enter. Once
you’ve started Point2Play, it goes into its con-
figuration wizard, which leads you through the
setup process. Proceed through the introduc-
tion by clicking Next, and you should see a
screen like the one shown in Figure 1.

Fill in your TransGamer account information
so that Point2Play can download the actual
Cedega system. If applicable, fill in your HTTP
proxy information. If you don’t know whether
you use a proxy, you most likely don’t. Click on
forward. Point2Play will verify your account
information. If it checks out okay, you should
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Figure 1. First Step of the Point2Play Setup Wizard
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see the next screen, shown in Figure 2.
This screen is largely for you to verify the information about your system.

Click forward. Then you are presented with the next step of the installation,

which is Figure 3.
In this step, Point2Play tests your system to ensure

that you’re ready to run Cedega. Click forward to
begin the tests. You’ll see some gears spinning on the
screen, and your system also will play a few sounds.
Even if your system fails the tests, Point2Play still lets
you proceed. This is not always a bad thing. For
instance, on my SUSE 9.3 system with a specific graph-
ics card, the test for 3-D acceleration fails, even
though 3-D acceleration works for me. The real test

happens when you attempt to play Windows games. If
you see a red box when the tests are done, don’t be surprised if games
don’t run correctly. If this happens, you’ll need either to consult the
informal tech support forums at http://www.transgaming.org/forum
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Figure 3. Almost Done!

Figure 2. Second Step
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or your local Linux geek to see why things
aren’t working.

Finally, you should be presented with the
screen in Figure 4.

Once you click Finish, you should be pre-
sented with the main Point2Play screen, shown
in Figure 5.

Now, to install your favorite Windows game,
all you need to do is place the CD in the drive,
and then click on the large Install button
toward the top of the application. Proceed

though the
installation
process as nor-
mal, and you’ll be rewarded with an icon for
the game you just installed. It is rather creepy
to see Windows confirmation messages pop-
ping up in your favorite window manager for
the first time, but the end result is terrific.

If you’re a gamer like I am, check out Cedega
and enjoy your Windows games without having
to run Windows.�

Kevin is 22 years old and currently lives
in Nicaragua with his cat Guapo. He is
proud to use exclusively *nix systems,
especially with regards to his job as a
Software Engineer. He likes helping
others learn what he has learned,
whether it be computer knowledge,
playing bagpipes or Spanish.
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Figure 5. Can’t you taste the pending gaming frenzy?

Figure 4. We’re There!
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You can run some mainstream Windows games
under WINE (Wine Is Not an Emulator), a utility
that runs Windows-based applications in a unique
way. Instead of emulating Windows, which is a
slow and clunky process, it takes a Windows com-
mand from a program and uses a Linux command
in place of it. This means that instead of emulat-
ing a program, you are actually running it under
your own Linux environment. This is a huge task,
and as such, WINE is still unfinished software.

New computer users beware—this article isn’t
designed for the PC novice, but instead for inter-
mediate Windows gamers who are new to Linux.
If the terms Direct3D, OpenGL, software rendering
or 1600x1200 mean nothing to you, this isn’t
your article. But, if you’re a Windows gamer
who’s comfortable with this terminology, read on.
Because readers are clamoring for it, we’re going
to try to describe how to run different games
decently under WINE as often as possible. This
month, we’re covering an all-time classic, Deus Ex.

WHY SHOULD I PLAY IT?
Once voted Best Game Ever by PC PowerPlay—
and it still ranks in the top five—Deus Ex is a
genre-busting piece with well-crafted gameplay
and a rich storyline that still plays well several
years later (not to be confused with its sequel:
Invisible War). Set in the not-too-distant future,
the player assumes the character of J.C. Denton,

WWiinnddoowwss  GGaammiinngg  oonn  LLiinnuuxx::  DDeeuuss  EExx
How to get one of the best games ever to work on Linux.

JOHN KNIGHT

Figure 1. Megalomania aplenty with Deus Ex’s killer plot.
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an agent of UNATCO, a UN peace-keeping force.
Fighting against a terrorist force and a virus that’s
sweeping the world, the game gets you comfort-
able in your role until a point where the story
turns upside-down, and you have to forget every-

thing you thought you knew.
Combining the best elements of a role-playing

game (RPG) and a first-person shooter (FPS), Deus
Ex provides a truly cross-audience experience.
Instead of leaving your fate to a roll of the dice,

RPG fans can use their own skills to decide their
fate. Instead of running down endless corridors
with a generic character and a hokey plot, FPS
fans can decide what kind of player they want to
be—whether it’s a player that jumps straight into
a fight or someone who sneaks past everyone
unnoticed—the choice is yours.

INSTALLATION—KONQUEROR
Open the CD in Konqueror and click on
Setup.exe. If you’re lucky, it will start automatical-
ly. If not, right-click and choose the entry called
WINE and wait a few moments. If this doesn’t
work, right-click on the file and choose Open
With→Other. Type wine in the empty field and
check the boxes for Run in terminal and
Remember application association for this type of
file. If this still doesn’t work, you probably don’t
have WINE installed. Install WINE using your
favorite package manager and then try again.

INSTALLATION—NAUTILUS
Open the CD and try double-clicking on Setup.exe
and wait to see if it starts. If it doesn’t, right-click
on the file and see if there’s an option to open it
with WINE. If not, choose Open with Other
Application and type wine in the new dialog box.

The installer should now start. Choose your lan-
guage and click Next and then I Agree for the
license agreement. You now have a choice of
where to install the game. Unless you know what
you are doing, simply click Next. Now comes the
component choice, choose everything except
DirectX. Click Next, and you are ready to install the
game. Click Install and wait a few minutes until it
has copied all of the game files to hard disk.
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Figure 2. The bleak future of America? A decapitated Statue of Liberty!
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RUNNING FOR THE FIRST TIME
You are now presented with a screen called Deus
Ex Options; choose Play from the menu. Next
comes the 3-D Device Selection menu. Click on
the Show all devices option, and choose OpenGL

Support (Figure 3). Now click Next, Next and
Run!, and then wait. If all went well, you should
now be in the game. If not, read the trouble-
shooting section after this. To access the game
the next time, look in your menu under

Wine→Programs→Deus Ex→Play Deus Ex.
If you don’t have any of these entries, you

still can browse for the game manually, but to
get there, you have to enable Show Hidden
Files. Under Nautilus and Konqueror, simply
click on View→Show Hidden Files. Now browse
your way to .wine/drive_c/DeusEx from your
home directory. You will see a folder called
System; this is where the game’s main exe-
cutable lies, and you will probably want to
make a link to it. This is a simple process, and
we’ll show you how to do it in both Konqueror
and Nautilus. (Note that this is unnecessary if
you have the menu entries available.)

LINKING—KONQUEROR
Open up a new window and go to your home
directory (or wherever you want the link to be
made). Click and drag the System directory to
the window with your home directory. A new
dialog menu appears with a choice of Move
here, Copy here and Link here; choose Link
Here. The link will be made, making it easy to
get to the folder in future. However, the link
will be called System, and this might be a bit
confusing later on; feel free to rename it to
something like Deus Ex link.

LINKING—NAUTILUS
Open a new window and open your home direc-
tory. Middle-click (probably your mouse-wheel—if
not, click the left and right mouse buttons at the
same time), and drag the folder in to your home
directory’s window. Choose Link here in the new
menu and the link will be made; feel free to
rename it.
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Figure 3. OpenGL is the optimal choice, but software rendering is there if you need it.
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To run the game, follow the instruc-
tions as before in the Installation section,
but run the file called DeusEx.exe.

PROBLEMS AND TROUBLESHOOTING
OpenGL rendering is what you’re aiming
for, but decent OpenGL support wasn’t
included until later versions. If you have
the Game of the Year Edition or a later
release version, you should be fine. Players
with older versions may have to resort to
software rendering. However,
Transgaming’s Cedega runs any version
quite well with the in-game standard
Direct3D rendering. I tried patching it, but
to no avail; the game simply didn’t start
when patched.

If the game crashes the first time,
don’t be disappointed; it should run the
second time. If all else fails, there’s always
ugly-old software rendering, but try play-
ing around in safe mode first (which is
available under the same menu as the
game). Drivers always can be a problem
too, and updating your drivers is a good
idea, as old drivers can result in graphical
glitches and full-screen problems.

Depending on your version of WINE
and your video card drivers, you might
find that desktop components like KDE’s
kicker are in the way when you go to
full screen; if this is so, you can at least
hide the Kicker by clicking on its Hide
Panel. Or, if you’re the kind of user
that’s comfortable and familiar with
lightweight desktops, I recommend try-
ing out the game under a desktop like

Fluxbox or Openbox, where large sec-
tions of GUI aren’t in the way in the
first place. I also found that sometimes
KDE’s desktop icons can be thrown
around into random positions. If so, it
certainly is worth trying Deus Ex under
another desktop.

After running the game, you might
find that you have either no sound or very
loud sound, or that 3-D graphics are now
running poorly. For sound, check your vol-
ume levels; it appears that WINE sends
volume levels haywire. I’ve found that
sometimes the Master control becomes
muted, and on older versions of WINE,
I’ve had the Wave volume at 100%. For
graphics, if video performance becomes
poor, try logging out and restarting the X
Windows System. To restart the X
Windows System, look in the login menu
at startup under Actions. If you don’t have
this, try using the keyboard shortcut of
Ctrl-Alt-Backspace. If you still don’t have
success, reboot your machine.

Although there are a number of prob-
lems, the game really warrants the effort.
WINE gaming is always a tricky venture,
and Deus Ex is actually one of the better-
behaved games. The WINE Project is
always getting better, but the constantly
updated versions of Windows makes for a
moving target, adding to an already
immense task. If you stick with it and get
the game running, you won’t be disap-
pointed. Deus Ex has amazing gameplay,
which is truly rewarding, making for an
all-time classic.�

TUX EXPLAINS

50www.tuxmagazine.com

WINE TIPS

Using menus can be very convenient, but
opening up a program via the command
line is usually the best option. Quite
often a program won’t exit properly and
will still be running in the background. If
you have a command-line terminal open,
and you don’t have the usual blinking
cursor, the program is probably still run-
ning. Try pressing Ctrl-C to kill badly
behaving programs.

WINE is unfinished and probably will
not run perfectly. If a program fails to
run, try updating to the latest version of
WINE. At Winehq, there is an application
database for Windows programs
(http://appdb.winehq.org). Look around
for your program, and see if there are
any comments made by other users as
to how they got the program to work.

The standard version of WINE is
designed for all Windows applications.
For something that’s gaming-specific,
try Transgaming’s Cedega, available at
http://www.transgaming.com. Cedega
is based on WINE, but with added
extensions specifically for gaming. WINE
is the better choice for normal Windows
applications (plus it’s free), but Cedega
runs a lot more games. It is a commer-
cial application, but don’t worry, the
price is reasonable. See Kevin Brown’s
article on Cedega on page 42.

John Knight is a 21-
year-old, rock-climbing,
Japan-loving megalo-
maniac, trying to take
over the world from his
bedroom via his key-
board. He spends most
of his time tinkering
with MPlayer and head-
banging to his MP3s.

http://appdb.winehq.org
http://www.transgaming.com
http://www.tuxmagazine.com

	COVER
	CONTENTS
	P2P
	From the Publisher: Patents and Innovation
	From the Editor in Chief: Who Let the GNOME Dogs Out?
	Letters
	Q&A with Mango Parfait

	HOME PLATE
	Digital Exhibitionism, Part II: gThumb

	SUITED UP
	KDE Everywhere You Go: Platform-Independent Personal Information Management

	TUX EXPLAINS
	Inkscape: the Elements of Design, Part I
	GnuCash
	I've Got Peace Like an iRiver
	Playing Windows Games on Linux with Cedega
	Windows Gaming on Linux: Deus Ex




